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Copyright Notice:  

Release 6.5.3 

Copyright © 2006-2015 Lumenera Corporation.  All rights reserved. 

The contents of this document may not be copied nor duplicated in any form, in whole or in part, 
without prior written consent from Lumenera Corporation.  Lumenera makes no warranties as to 
the accuracy of the information contained in this document or its suitability for any purpose.  The 
information in this document is subject to change without notice. 

 

License Agreement (Software): 

This Agreement states the terms and conditions upon which Lumenera Corporation ("Lumenera") 
offers to license to you (the "Licensee") the software together with all related documentation and 
accompanying items including, but not limited to, the executable programs, drivers, libraries, and 
data files associated with such programs (collectively, the "Software"). 

The Software is licensed, not sold, to you for use only under the terms of this Agreement. 

Lumenera grants to you the right to use all or a portion of this Software provided that the Software 
is used only in conjunction with Lumenera's family of products.  

In using the Software you agree not to: 

a) decompile, disassemble, reverse engineer, or otherwise attempt to derive the source code for 
any Product (except to the extent applicable laws specifically prohibit such restriction); 

b) remove or obscure any trademark or copyright notices. 

 

Limited Warranty (Hardware and Software): 

ANY USE OF THE SOFTWARE OR HARDWARE IS AT YOUR OWN RISK. THE SOFTWARE IS 
PROVIDED FOR USE ONLY WITH LUMENERA'S HARDWARE AND OTHER RELATED 
SOFTWARE. THE SOFTWARE IS PROVIDED FOR USE "AS IS" WITHOUT WARRANTY OF 
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY LAW, LUMENERA DISCLAIMS ALL 
WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, QUALITY 
AND FITNESS FOR A PARTICULAR PURPOSE. LUMENERA IS NOT OBLIGATED TO 
PROVIDE ANY UPDATES OR UPGRADES TO THE SOFTWARE OR ANY RELATED 
HARDWARE. 

 

Limited Liability (Hardware and Software): 

In no event shall Lumenera or its Licensor's be liable for any damages whatsoever (including, 
without limitation, incidental, direct, indirect, special or consequential damages, damages for loss 
of business profits, business interruption, loss of business information, or other pecuniary loss) 
arising out of the use or inability to use this Software or related Hardware, including, but not 
limited to, any of Lumenera's family of products. 

 

Product Warranty 

Lumenera Corporation warrants to the original purchaser that our cameras are guaranteed to be 
free from manufacturing defects for a period of two (2) years from the original date of purchase.  
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For complete product warranty details refer to the Lumenera web site. 

http://www.lumenera.com/support/warranty-policy.php 

Any returning product, specifically those being returned under warranty, must follow the Returned 
Material Authorization (RMA) process. Any units being returned are to be properly packaged (in 
original packing – if possible). Lumenera will not cover damage sustained in shipping due to 
improper packing. 

For RMA instructions, please refer to the Lumenera website. 

http://www.lumenera.com/support/rma.php 

 

RoHS/WEEE Compliance Statement 

The Restriction of Hazardous Substances in Electrical and Electronic Equipment (RoHS) 
Directive was passed into law by the European Union (E.U.). It affects manufacturers, sellers, 
distributors and recyclers of electrical and electronic equipment containing lead, cadmium, 
mercury, hexavalent chrome, polybrominated biphenyl (PBB) and polybrominated diphenyl ether 
(PBDE). After July 1, 2006 the use of these materials will be banned in new products sold in 
Europe. The RoHS Directive complements the WEEE Directive. China is expected to adopt 
similar legislation within a similar timeline. 

The Waste Electrical and Electronic Equipment Directive (WEEE) aims to reduce the waste 
arising from electrical and electronic equipment and to improve the environmental performance of 
all those involved in the life cycle of these products. 

Lumenera is committed to protecting people and the environment and we are working on 
identifying any materials used in our processes that could pose a potential hazard to our 
employees, customers or the environment. 

For this reason we are committed to have all our products comply with the RoHS and WEEE 
directives. We are constantly improving our compliance with these directives. For more 
information on our compliance or to track our progress please refer to our website. 

 

Trademarks and Proprietary Names: 

Lumenera Scientific, INFINITYLite, INFINITY X, INFINITY 1, INFINITY 2, INFINITY 3, INFINITY 
4, INFINITY 5, and DeltaVU are trademarks of Lumenera Corporation.  This manual may refer to 
other product names, which may be trademarked by their respective companies, and are used 
herein for identification purposes only.   

http://www.lumenera.com/support/warranty-policy.php
http://www.lumenera.com/support/rma.php
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Federal Communications Commission (FCC) Statement 

This equipment has been tested and found to comply with the limits of a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a residential 
environment.  This equipment generates, uses, and radiates radio frequency energy, and if not 
installed and used in accordance with the instructions, may cause harmful interference.  
However, there is no guarantee that interference will not occur.  If this equipment does cause 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to correct the interference by one of the following measures: 

 

 Reorient or relocate the receiving antenna.  

 Increase separation between the equipment and receiver.  

 Connect the equipment into an outlet on a circuit different from which the receiver is 
connected.  

 Consult the dealer or an experienced radio/TV technician. 
 

Any changes or modification to said product not expressly approved by Lumenera could void the 
user's authority to operate this device. 
 
Shielded and grounded cables and connectors must be used to meet FCC emission limits.  
Lumenera takes no responsibility for any radio or television interference caused by using cables 
or connectors other than those recommended. 
 
This device complies with part 15 of the FCC Rules.  Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 

 

European Community (CE) Statement 

Products: INFINITY 1, 2, 3, 4, 5, X, Lu1175, Lu1175X, Lu1205, Lu1135, Lu1165, Lw1235, 
Lu1275, Lu1335, Lu1375, Lt365, Lt665 and Lw1625 USB Scientific Cameras. 
 
Directives: 2001/59/EC (General Product Safety Directive) Self-declared 89/336/EEC (EMC 
Directive).  
 
Standards to which conformity is declared:   EN55024: 1998 

EN55022: 1998 (Class B) 
EN61000-3-2: 1995 
EN61000-3-3: 1995 

 
Manufacturer’s Name and Address:  Lumenera Corporation 

7 Capella Court 
Ottawa, ON 
K2E 8A7 
Canada 

 
Type of Equipment:  USB Scientific Digital Camera 
 
First Year of CE Conformity: 2003 
 
This is to certify that the Lumenera USB Scientific Cameras meet or exceed the standards for CE 
compliance per the Council Directives noted above.  All equipment is built at Lumenera 
Corporation, and pertinent testing documentation is available for verification. 
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 1 1

Introduction 

 
The INFINITY ANALYZE application package is designed to work exclusively with the 
Lumenera INFINITY camera models.  It provides all of the functions necessary to 
control all available camera settings, for both the live video preview and the capture of 
still images.  In addition, ANALYZE provides a comprehensive set of measurement and 
analytical operations useful in many clinical, laboratory, and inspection operations. 
 
For details on the features and performance of a particular INFINITY camera model, 
refer to the INFINITY CAPTURE User‟s Manual. 
 
The INFINITY ANALYZE application is licensed for use while an INFINITY camera 
model provides the function of the application license key.  Without a camera connected 
to the computer, INFINITY ANALYZE will operate in trial (demo) mode.  All application 
functions for post-processing of images are available, but results cannot be saved.  A 
separate USB key can be ordered from Lumenera, to provide an additional license for 
INFINITY ANALYZE, allowing the application software to be operated on a computer 
without the camera being present.  Contact scientificsales@lumenera.com to order 
additional licenses. 
 
Additionally, the Multi Focus Composition and Spherical Aberration Correction functions 
are included for demonstration purposes.  When evaluating the performance of these 
functions on your own images, the results are permanently watermarked with the word 
„EVALUATION‟.  Contact Lumenera to purchase the Advanced Features Package 
(LuIAP-2) if these functions are important to your operations. 
 
 
  

mailto:scientificsales@lumenera.com
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  2

Getting Started 

 
It is assumed that the users of INFINITY ANALYZE and the readers of this document 
have a working knowledge of microscopes, digital cameras and Microsoft Windows. 
INFINITY ANALYZE may be used for both compound and stereo microscopes. It also 
contains a few functions specifically designed for fluorescent imaging. INFINITY 
ANALYZE conforms to the Microsoft Windows User Interface Guideline and so is similar 
to other programs in opening files and mouse operations.  
 
This section lays a background for image capture and analysis with INFINITY 
ANALYZE. 

2.1 Image 

 

2.1.1 Color Models 

 
Digital images record colors by numbers. Different color models are used to interpret 
the digital values representing pixel intensity readings. INFINITY ANALYZE uses a 
number of color models for image acquisition, display, processing and printing. In most 
cases the underlying color model is transparent to users.  
 
RGB 
 
A large portion of the visible spectrum can be represented by mixing three basic 
components of coloured light in various proportions and intensities. The primary 
components used are the colors: red, green and blue (RGB). Computer screens use an 
RGB model to display graphics and images. Most 8-bit image processing programs, 
including INFINITY ANALYZE, employ a triplet of integers in the range [0,255] to 
represent a color being described by the RGB model.  
 
 
HSI 
People interpret colors by their three fundamental characteristics: hue, saturation and 
intensity (HSI). Hue is the wavelength or frequency of light reflected from or transmitted 
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through an object. Most often hue is identified by the name of the color such as orange 
or purple. Saturation is the strength or purity of the color and represents the amount of 
gray in proportion to the hue.  Intensity stands for the relative lightness or darkness of 
the color. It is the energy contained in the color. 
 
As in the case of the RGB model, INFINITY ANALYZE uses a triplet of integers of the 
range [0,255] to represent a color based on the HSI model. However, a particular 
camera supported by INFINITY ANALYZE may implement a camera-specific range of 
values for hue, saturation or intensity and may not use integers to represent the value.  
 
Luminance is sometimes used in place of intensity in describing a color in the HSI 
model. In camera terminology gain has the greatest similarity to intensity. Whenever 
gain is involved, it is multiplicative instead of additive as in the processing of a still 
image.  
 
Grayscale and Indexed Color 
 
When dealing with a monochrome camera or image, the Grayscale model is used to 
represent the values from coloured objects. In this case, a single integer in the range [0, 
255] is used to describe the energy content of a color, corresponding to the intensity 
channel of HSI model. 
 
Color Components and Channels 
 
In the RGB model, each of the red, blue or green values is referred to as a component 
or channel of the color. Color component and color channel terms that are used 
interchangeably in this document. The same is true for the HSI model and the 
Grayscale model. A color described by the HSI model has three components or 
channels, namely the hue channel, the saturation channel and the intensity or 
luminance channel. A color described by Grayscale model has only one channel, 
namely the intensity channel. 
 
The triplet used by the RGB and the HSI models, and the single number used by 
Grayscale model, are called the color value. 
 
Color Model Conversions 
 
RGB and HSI are equivalent means to describe colors. The main reason to use multiple 
color models is to facilitate the understanding of image processing of INFINITY 
ANALYZE. The internal conversion between the two models is handled implicitly and 
needs no user input. 
 
RGB and HSI may also be used to represent a monochrome image as Grayscale model 
does. In this situation, the three channels of RGB are set equal, and the hue and 
saturation channels of HSI are set to zero.   
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2.1.2 Raster Images and Vector Graphics 

 
The components that make up the scene on a computer screen fall into two main 
categories: raster images and vector graphics.  
 
Raster images use a grid of small squares, known as pixels, to represent pictures. Each 
pixel in a raster image has a specific location and color value assigned to it. When 
working with raster images, groups of pixels rather than objects or shapes are being 
edited. Because they can represent subtle gradations of shades and color, raster 
images are the most common electronic medium for continuous-tone pictures such as 
photomicrographs. 
 
The terms raster image and pixel array are used interchangeably in this document. In 
fact, a raster image may also be described as a matrix of points. The distance between 
neighbouring points on a row is referred to as the horizontal sampling interval. The 
distance between neighbouring points on a column is referred to as the vertical 
sampling interval. Sampling interval multiplied by the number of columns and rows is 
exactly the size of the field of view over which the image has been captured. 
 
Vector graphics consist of lines and curves defined by mathematical objects called 
vectors, which describe pictures according to their geometric characteristics. The lines 
or curves of an object can be painted with a specific color. The interior of the shape 
enclosed by these lines and curves may also be painted with a specific color. Vector 
graphics can have only a limited number of colors and cannot represent natural scenes. 
They are mainly useful in annotating raster images. 
  
Raster images are resolution-dependent, that is, they represent a fixed number of pixels 
and can appear jagged and lose detail if they are scaled on-screen, or if they are printed 
at a higher resolution than they were created for. On the other hand, vector graphics are 
resolution-independent; that is, they are defined by analytical formulas and so can be 
scaled arbitrarily to appear crisp and sharp on any output device at any resolution. 
 
INFINITY ANALYZE works with both raster images and vector graphics. The images 
obtained from cameras are raster images. The annotation objects created with 
INFINITY ANALYZE are vector graphics. In a broad sense, both raster images and 
vector graphics are considered digital images or digital pictures. Vector graphics are 
always converted to raster images for purpose of display, a process known as 
digitization. INFINITY ANALYZE can also burn vector graphics into raster images. This 
is the same as digitization but is irreversible.  
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2.1.3 The Layers 

 
For any image processing program that is more sophisticated than a simple image 
viewer, additional information is stored with the pixel data. For example, sampling 
intervals and magnification settings are also recorded in an image within INFINITY 
ANALYZE. In fact, even the pixels have to be organized into layers. Each layer is either 
a raster image or a vector graphics object. Layers may be combined in various ways to 
produce specific presentations of an image within INFINITY ANALYZE. The 
presentation itself is a simple raster image. 
 
An image in INFINITY ANALYZE has multiple layers. The bottommost layer is the pixel 
array, also called the pictorial layer. The topmost layer is the overlay, where the 
graphics generated by measurement operations and the annotations layer where the 
micrometer and user specified graphics are placed. In between is the mask layer. This 
layer is used by advanced editions of INFINITY ANALYZE to hold segmentation results. 
 
In displaying an image, its pictorial layer is drawn first. The layers above the pictorial 
layer are drawn later and may obscure the pictorial layer. 
 
When INFINITY ANALYZE is running, there can be temporary layers hosting annotation 
objects. Each annotation object occupies a temporary layer by itself. The temporary 
layers are above any other types of layers. Annotation objects are burned into the 
images when saved as BMP, JPG, or TIF file formats, or preserved as annotation layers 
in images saved in the native .SIF file format.,  

2.1.4 The Active Image 

 
With INFINITY ANALYZE, many images can be open simultaneously. However, only 
one of them may receive input focus. This image is referred to as the active image. In 
this document, the active image, the current image, or sometimes the active image 
window, are used interchangeably. 
 
The active image window can be easily distinguished from the other image windows. 
The title of the active window is appended to the title of the main window, and the title-
bar is highlighted. When tabs are enabled for image windows, the color of the tab of the 
active image is the same as the color of the inner frame of the main window, as shown 
below in yellow. The first example illustrates the active image window in normal state. 
The second example illustrates the active image window in maximized state. 
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2.1.5 The Empty Image Window 

 
INFINITY ANALYZE employs an empty image window to display live images from the 
camera. The live image may pan and scroll in the same way as a still image, i.e. the 
hand tool is also available for live image.  Use the Fit to Window icon to change 
between Full Field of View and a selected Region of Interest (ROI), for pan and scroll 
functionality.   
 
A new preview window can be opened from the File menu (New for Video Preview), or 
from an icon in the toolbar, if the current one is closed.  Only a single Live Preview 
window can be open at one time.  It is also possible to toggle the Live Preview window 
using the large button provided at the top of the Camera Control panel. 
 

 

The button is presented this way when no live preview window is 
operating.  Click the button to launch a new live preview window.  

 

Use this button to close the live preview window 

 

2.2 Workspace 

 
Besides image windows, many other windows or user interface elements reside within 
the main window of INFINITY ANALYZE. These include menus, toolbars, status bar and 
auxiliary windows providing additional information about the images or control of the 
camera. 
 

2.2.1 Menu 

 
The menu can be either docked or floating. Double-click its grip or caption bar to toggle 
between the two states. When the menu is docked, it can be docked to any of the four 
sides of the main window. Drag the grip or caption of the menu to adjust its position or 
to dock it to a particular side of the main window. The grip of the menu is the dot matrix 
at the left or top of the menu in docked state.  
 

2.2.2 Toolbar 

 
INFINITY ANALYZE has four toolbars. Each toolbar can be either shown or hidden. 
When a toolbar is shown, it can be either docked or floating. Double-click its grip or 
caption to toggle between the two states. When a toolbar is docked, it can be docked to 
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any of the four sides of the main window. Drag the grip or caption of a toolbar to adjust 
its position or to dock it to a particular side of the main window. The grip of a toolbar is 
the dot matrix at the left or top of the toolbar in docked state. 
 

2.2.3 Status Bar 

 
The status bar is located at the bottom of the main window. Depending on whether a 
still image or the video is being displayed in the active image window, the status bar 
provides different information.  The image below shows the 12 fields on the right side of 
the status bar.  The frame rate field is not shown. 
 

 
 
The status bar is divided into thirteen panes from left to right. The information displayed 
in each pane is as follows: 
 

Pane Index Still Image Live Image 

1 
(Leftmost) 

 Display live video frame rate. 

2 Mouse position in horizontal direction, in 
pixels, relative to the top left corner of the 
active image. 

The horizontal offset of the 
region of interest on the 
camera. 

3 Mouse position in vertical direction, in 
pixels, relative to the top left corner of the 
active image. 

The vertical offset of the 
region of interest on the 
camera. 

4 The red component of the pixel at the 
mouse position. 

The width of live image, in 
pixels. 

5 The green component of the pixel at the 
mouse position. 

The height of live image, in 
pixels. 

6 The blue component of the pixel at the 
mouse position. 

The number of columns of 
the pixel array of the camera. 

7 Active image zoom ratio. Preview zoom ratio. 

8 The maximum width of image. The width of full resolution. 

9 The maximum height of image. The height of full resolution. 

10 Units used for calibration. Units used for calibration. 

11 The magnification of the active image. The magnification setting of 
the system micrometer. 

12 The width of the active image, in microns. The width of the whole field 
of view, in microns. 

13 The height of the active image, in microns. The height of the whole field 
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(Rightmost) of view, in microns. 

 

2.2.4 Auxiliary Window 

 
INFINITY ANALYZE has six auxiliary windows: Control Panel, Help Desk, Database, 
Measurement Result, Photometry, and Histogram. Each of these auxiliary windows can 
be either visible or hidden. When an auxiliary window, except Control Panel, is shown, it 
can be either docked or floating. Double-click the grip or caption of an auxiliary window 
to toggle between the two states. When an auxiliary window is docked, it can be docked 
to any of the four sides of the main window. Drag its grip or caption to adjust the 
position of an auxiliary window or to dock it to a particular side of the main window. The 
grip of an auxiliary window is the dot matrix at the left or top of the caption bar of the 
window in docked state. All the auxiliary windows can be resized in the same way as an 
ordinary window. 
 
Control Panel 
 
The Control Panel provides access to all camera functions and image acquisition 
commands. It also controls image capture options and how acquired images are 
cached.  
 
Two panes, Imaging Control and Field Group, comprise the Control Panel. The 
Imaging Control Panel is further divided into seven sub-panes for specific aspects of the 
image display and capture process. Sub-panes are collapsible. To collapse a sub-pane, 
click the arrow in its top right corner. To expand a collapsed sub-pane, click the arrows 
in the top right corner again. The arrows at the top left corner of a sub-pane point 
upward to indicate the expanded state and downward to indicate the collapsed state.  
 

 
 
When INFINITY ANALYZE is launched, the displayed panes in the Control Panel are 
restored to the state they were in when the application was last closed.  
 

The Control Panel sub-panes are described in section 4 – Imaging Control 
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Click to hide Control Panel. 

 
Click to go to the previous 
pane. 

 
Click to go to the next pane. 

 
Click to go to Field Group. 

 

Click to go to a pane directly. 

 
Help Desk 
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The Help Desk provides context sensitive information for commands that involve 
extended mouse actions. 
 
Database 
 

 
 
The Database panel provides full control over the built-in database. Some commands 
may only be available from this auxiliary window. For example, click a column header to 
sort the list. This command is not accessible from the application menu. 
 
Measurement 
 

 
 
This auxiliary window is used to hold measurement results. A row is also referred to as 
an entry. As illustrated above, an entry consists of four cells, namely the command that 
generates the entry, the parameter that is being measured, the measurement result and 
unit. A measurement command may generate more than one entry because two types 
of parameters may be measured with a single command.  
 
The display of measurements can be sorted in ascending or descending order simply by 
clicking the left mouse button on the column header.  To restore the measurement 
results display to their original captured sequence, use the Measure menu to choose 
the option titled: Unsort Measurements. 
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Entries in the Measurement window may be highlighted using the mouse and dragged 
to an external spreadsheet program for further processing.  With the external program 
already running, drag the highlighted measurement data over the program icon in the 
task tray at the bottom of the screen.  This brings the spreadsheet program to the 
foreground where the measurement data can be dragged to the desired location.  
Release the mouse button to paste the selected data into the spreadsheet at the mouse 
pointer location. 
 
Photometry 
 
The Auxiliary window for Photometry results is used to show the pixel intensity results 
for two different features within ANALYZE.  One tab is used to display the statistical 
results and counts of pixel intensities matching areas identified during measurements, 
while the second tab shows similar data for areas identified by the Cell Counting 
operation.  The data in these two tables can be highlighted by mouse selection and 
dragged to an open spreadsheet. 
 

 
 
 

Histogram 
 
A histogram is a graphic representation of the number of pixels at each brightness level 
in an image. INFINITY ANALYZE plots histograms for all three channels of the active 
image based on RGB color model. In the black square box, the x axis represents the 
color value from darkest (0) at the far left to brightest (255) at the far right; the y axis 
represents the frequency, i.e. the total number of pixels with that value; the origin of the 
histogram is the bottom left corner of the black box. Note that histograms of red, green 
and blue channels are shown in the same coordination system as red, green and blue 



Lumenera INFINITY ANALYZE 
User’s Manual  Release 6.5.3 

Page 22  Copyright  2006-2016 

bars and so they may overlap. The following table helps to tell the overlapping range of 
the histograms. 
 
 

  
 

 
The histogram can be shown for both still and live 
images. For a still image, its histogram is updated 
whenever the image itself is being modified in any 
way, including the way it is being displayed. For a 
live image, its histogram is updated every three 
seconds. In both cases, the histogram is only for the 
part of the active image that is visible on computer 
screen. 
 
 
 
 

 

Red and Green 

 

Red and Blue 

 

Green and Blue 

 Red and Green and Blue 
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Look-Up Table 
 
The title bar of the histogram pane includes icons used to access Look-up Table (LUT) 
functions.    When enabled the LUT is applied to the live preview window providing 
instant feedback based on the Red, Green, and Blue channel manipulations.  Each 
channel can be modified individually, or all three channels can be set to be the same.   
The LUT can be enabled or disabled as desired.  Use the File menu to access the 
option that applies the active LUT to a captured image. 
 
The horizontal axis of the histogram represents the image input intensity values from 
minimum (0) on the left, up to maximum (255) on the right.  The vertical axis represents 
the corresponding output intensity value from minimum (0) at the base, up to maximum 
(255) at the top.  The line displayed across the histogram represents the point at which 
an input intensity value is transitioned to the corresponding output intensity value.  
Therefore, a line sloping upwards from the bottom left corner to the top right corner 
represents a neutral LUT definition, where each input value maps to the identical output 
value.  An inverse look-up table is shown by a line sloping down from the upper left 
corner to the bottom right corner, resulting in all minimum input values being 
transitioned to maximum output values (and vice versa), such that the channel becomes 
a negative representation of the original. 
 

 
 
The LUT can be modified either graphically or numerically.   To define the LUT 
graphically, click the mouse on the one end of the line displayed on the histogram.  
There are two control points available to manipulate into a slope that produces the 
desired result.  Each of the control points can be manipulated individually by clicking 
either on the square icons on the line, or on the line itself to the outside of the control 
points.  Click on the line between the control points and drag the graphic to perform 
translational adjustments to the line slope.   
 
The histogram is adjusted to display the LUT adjusted image pixel intensities. 
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Enable / Disable the LUT on the Live Image 

 Reset the active LUT channel  

 
Open the LUT editing dialog 

 Make the Red channel active 

 Make the Green channel active 

 Make the Blue channel active 

 Activate all three channels 

 
Automatically stretch the histogram output 

 
 

 
 

The dialog above is displayed when the icon  is clicked in the histogram panel.  Use 
this panel to select a specific LUT channel or to apply changes to all three channels at 
the same time.  It provides an easy option to generate an inverse LUT, and can be used 
to specify the actual coordinates for control points on a relative scale from (0,0) to (1,1). 

 

 

Enter the (x,y) coordinate of the first 
control point 

 

Enter the (x,y) coordinate of the second 
control point  

 
Invert the current LUT 

 

Select the active channel or all 
channels  

 
Click OK to save the modifications and 
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close the dialog 

 
Rollback any changes made to the 
dialog settings and close the dialog 

 

 
 
The LUT menu is accessed from the Camera -> Lookup Table menu.  Each function 
represented with an icon beside has been explained in the table above.  Use the Apply 
to Still Image option on this menu to apply the LUT to the active image in the ANALYZE 
working area.  Use the Load… and Save… options to restore or save an LUT definition. 
 
The Camera -> Stretch Histogram menu function can be used to enable or disable the 
application‟s control of the camera output via the histogram.  When this function is 
enabled, the camera output from darker regions will be adjusted to make them more 
visible in the output image.  Use of this function may result in the image output 
containing high levels of visible „noise‟. 
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  3

Menu Commands 

 
Most commands are accessible from the menu. Some of the more frequently invoked 
commands also have toolbar buttons and/or shortcut key combinations associated with 
them. Those commands that are not accessible from the menu are described in Section 
3 -Other Commands. 
 
Relating a toolbar icon to a menu item 
 
The toolbar icons denote the button functions available on the various toolbars.  The 
same icons appear to the left of the corresponding menu items on the dropdown menus. 
 
Relating a shortcut key combination to a menu item 
 
A short textual description of the shortcut key combination is shown to the right of the 
corresponding menu item.   
 
INFINITY ANALYZE has 5 major menus: 
 

1. Document Menu 
2. Main Frame Menu 
3. Field Group Context Menu 
4. Image Window Tab Context Menu 
5. Toolbar and Auxiliary Window Context Menu 

 
Most work will be carried out by commands in the Document Menu, which is the default 
menu when INFINITY ANALYZE starts up.  
 
The Main Frame Menu will replace the Document Menu whenever there is no image 
window in the main window. The commands contained in this menu are mainly useful in 
creating a new image window, by New for Video Preview or Open, or to exit from 
INFINITY ANALYZE, by selecting Exit. The Main Frame Menu will not appear when 
there is an image window in the main window.  
 
The Field Group Context Menu may be brought up by right-click anywhere within Field 
Group. 
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The Image Window Tab Context Menu may be brought up by a right-click anywhere 
within the tab area of image windows. 
 
The Toolbar and Auxiliary Window Context Menu may be brought up by a right-click in 
any area of the main window that is not occupied by other menus, toolbars, auxiliary 
windows or image windows. 
 
In the following paragraphs only the Document Menu is described. The other menus 
often duplicate part of the Document Menu to provide a level of convenience. Where 
they are unique, they typically represent simple commands that are self-explanatory. 
 

3.1 The File Menu 

 
The File menu commands are used to open, save, 
print and capture images. Camera manipulation 
commands that were previously found here have 
been moved to a new Camera menu. 
 

3.1.1 Open 

Use the Open command to load existing image files.  
The file open dialog displays any image file types 
that are recognized by INFINITY ANALYZE 
 
Multiple images from a single folder can be opened 
simultaneously, whether they are the same or in 
different image formats. Besides the native image 
format (*.sif), numerous commonly used image 
formats are supported. Files of unsupported formats 
will be filtered out and will not be visible in the dialog 
box. 
 
Equivalent Commands 
 

 Drag one or more selected files in Windows Explorer and drop them in the main 
window of INFINITY ANALYZE. 

 Double-click a file of native image format (*.sif) in Windows Explorer. 
 
The application recognizes the following image file formats: 
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Format File 
Extension 

Remark 

Native SIF Contains complete information including 
calibration data 

Bitmap BMP Including both Windows and OS/2 bitmaps. 

Independent JPEG 
Group 

JPG Least loss and highest quality when 
decompressing. 

Tagged Image File 
Format 

TIF Reading the first page only. 

Portable Bitmap PBM Reading both ASCII and binary formats.  

Portable Gray Map PGM Reading both ASCII and binary formats. 

Portable Network 
Graphics 

PNG  

 
Note the native format (*.sif) preserves the most complete information for images 
acquired by INFINITY ANALYZE, including sampling interval and magnification settings. 
However, the other formats do not contain metrical information and cannot be used for 
taking further measurements when re-opened, unless re-calibrated. When such a file is 
opened, the sampling interval is assumed to be 1 micron and the magnification is 
assumed to be 100X.   

3.1.2 Close 

 
Use the Close command to remove the active image window. 
 
If the active image window is the only image window, closing this window will cause 
INFINITY ANALYZE to switch to Main Frame Menu. To go back to Document Menu, 
choose File > New for Video Preview to create an empty image window, or choose File 
> Open to load an image file. 
 

3.1.3 Close All Images 

Use the Close All Images command to remove all of the open image windows. 
 

3.1.4 Save 

 
Use the Save command to store the active image onto disk in the native format. 
 
If the active image has been previously saved in the native format (*.sif), this command 
will simply update the corresponding file. If the image has never been saved in the 
native format, this command will act as File > Save As. 
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3.1.5 Save As 

 
Use the Save As command to store the active image onto disk with a new file name or 
in a new format. 
 
The native image format (*.sif) and Metallograph format (*.meg) retains both pictorial 
and metrical information and are the best for archival purpose. The other image formats 
keep pictorial information only. 
 
The supported image formats are listed below. 
 

Format File 
Extension 

Remark 

Native SIF Containing complete information. 

Bitmap BMP Writing in Windows Bitmap format. 

Independent JPEG 
Group 

JPG Least loss and highest quality when 
compressing. 

Tagged Image File 
Format 

TIF Writing as single-page. 

 

3.1.6  JPEG Options 

 
By default, ANALYZE uses the Best selection for Image quality.  In some instances, a 
balance of image quality versus file size is required.  The JPEG Options dialog provides 
the user with the ability to choose a reduced image quality output to save on disk space, 
if desired.  A more aggressive compression is applied as the selections are made 
moving down the list from Best, resulting in the smallest file size and lowest image 
quality output from the option called Limited. 
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The JPEG Options menu item is only accessible when an INFINITY camera is 
connected.  Any post-processing and file conversion operations performed on JPG 
images when no camera is present will be saved with the same compression used in 
the original image. 

3.1.7 Convert File Format… 

 
When images have been saved to disk in the native .SIF file format, they retain useful 
information related to calibration, and annotation objects remain in dynamic layers.  
However the .SIF file format is not recognized by 3rd-party image display and editing 
software packages.  To share images with users who do not have access to INFINITY 
ANALYZE, it may be beneficial to batch convert native .SIF files into standard image file 
types such as .BMP, .JPG, and .TIF image types.  The Convert File Format… menu 
item invokes the dialog box shown below. 
 

 
 
 Use the Select file… button to launch a conventional folder browse window.  Use this to 
identify the folder location and candidate .SIF files for conversion.  Select either a single 
file, or use the capabilities of <Shift> click or <Ctrl> click to identify multiple files.  When 
files have been identified, click the Open button.  The folder browser window will close.  
Use the file format option buttons to choose the output file format for the converted .SIF 
files.  Choose the Convert button to start the process of file conversion.  The output files 
will use the same name as the input .SIF files, but their file extensions will match the 
selected file type.  A text message within the dialog box keeps track of the file 
conversion as it progresses. 
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3.1.8 Print Setup 

 
Use the Print Setup command to select a printer and set its properties for use with 
image hardcopy output. 
 

3.1.9 Print Image Layout 

 
Use the Print Image Layout command to specify whether all images or only the active 
image should be printed and the way each image is to be aligned and scaled. 
 
This command brings up the dialog shown below. All settings will be saved 
automatically for later use in the current and later sessions. 
 
 

 
 
 
Alignment 
 
This section determines whether all images or only the active image might be printed. 
Three modes are defined by INFINITY ANALYZE: AAA (All Images Automatically 
Aligned), CAP (Current Image Absolutely Positioned) and CFP (Current Image Fit to 
Paper). 
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 AAA. Under this mode, all images except empty ones would be printed. The 
layout and pagination of images are fully automatic. A zoom factor may be 
applied to all images before the final page layout is calculated. The zoom factor 
is specified in Zoom for AAA and CAP. The titles would also be printed under 
images.  

 CAP. Under this mode, the active image would be printed if it is not empty. The 
size and position of the printed image may be modified. The image may be 
zoomed according to the factor specified in Zoom for AAA and CAP. The image 
can be placed anywhere on the paper. The position of the printed image refers to 
the horizontal and vertical offset of the top left corner of the image with respect to 
the top left corner of the printable area of the paper, in millimeters. The offsets 
are specified in Displacement for CAP (mm). 

 CFP. Under this mode, the active image would be printed if it is not empty. The 
image is automatically scaled to fill the width or height of the paper, depending 
on aspect ratios of the image and paper. The aspect ratio of the image is kept 
constant. If the image could not occupy the whole printable area of the paper, it 
will be placed to the top side as far as possible but centered horizontally on the 
paper.  

 
 
Zoom for AAA and CAP 
 
This section specifies a zoom ratio of the images for use with printing under AAA and 
CAP modes. 

 
Note: It may be necessary to select a Zoom that is less than 1.0 for 
cameras with multi-megapixel output, to fit the image onto a page.  If the 
Print Preview presents only a blank page, then try reducing the Zoom  
down from 1, to 0.5 or 0.25.  With a reduced zoom, the image should 
appear on the Print Preview page.  Once the preview can be seen, it is 
possible to adjust the zoom to maximize the image appearance on the 
page. 

 
Displacement for CAP (mm) 
 
This section specifies offsets of the image for use with printing under CAP mode.  The 
origins of the image and paper are their top left corners. Horizontal displacement is 
defined as the distance between the leftmost column of the image and the left side of 
the paper‟s rectangular printable area. Vertical displacement is defined as the distance 
between topmost row of the image and the top of the paper‟s rectangular printable area. 
The distance is measured in millimetres.  
 
The Print Image Layout command is used to configure the printing but it does not initiate 
a printing process. 
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3.1.10 Print Preview 

 
Use the Print Preview command to simulate image printing on computer screen. 
 
In this mode, INFINITY ANALYZE menu, toolbars, auxiliary windows except the Control 
Panel are hidden as illustrated below. 
 

 
 

 
Note: If no image appears when Print Preview is requested, see the note 
in sect 3.1.9, on setting the Zoom level. 
 

 
When Print Preview has been selected, an enhanced print preview toolbar appears. 
There are seven buttons, the function of each is explained below. 
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Click to start the actual printing. 

 
Click to view the next page 

 
Click to view the last page 

 
Click to toggle between two-page view and single-page view. 

 
Click to zoom in the image 

 
Click to zoom out the image 

 
Click to exit the print preview mode. This is equivalent to pressing Esc key. 

 
 
The status bar will display the page number of the image being previewed. 
 
The main window shows the print layout of the images. Print preview has incorporated 
configurations set by both Print Setup and Print Image Layout. 
 

3.1.11 Print 

 
Use the Print command to output a hardcopy of the active image or all opened images. 
 
This command only initiates the printing process and does not specify how the printing 
should be done. The printer selection and configuration is carried out by Print Setup. 
The digital zoom factor, position and alignment of images are specified by Print Image 
Layout.   
 

3.1.12 Exit 

 
Use the Exit command to close INFINITY ANALYZE. 
 
This command prompts to save modified documents. INFINITY ANALYZE considers an 
image as a modified document if it has never been saved in native format or it has been 
processed or measured after the last time it was saved. 
 
Viewing an image in different ways, measurement in progress (not yet completed) and 
annotating an image (before the annotation objects are burned into images) are not 
considered as modifying an image. 
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3.2 The Camera Menu 

The Camera menu was introduced with release 6.5.0, 
to migrate the camera manipulation functions away 
from the File menu. 

3.2.1 New for Video Preview 

 
Use the New for Video Preview command to create 
an empty image window to display live images from 
the camera. 
 
The caption of the created window is the model or 
name of the camera presently attached to the 
computer. If no camera is connected or none of the 
connected cameras is working properly, the caption 
of the created window is “Video”. 
 
The camera serial number is appended to the window 
caption, after a dash. 
 

3.2.2 Capture 

The Capture menu provides access to the 
following functions related to acquiring an 
image from the camera. 
 
 

3.2.2.1 Image Capture 

Use the Image Capture command to 
acquire an image from the camera based on the present camera settings and 
capture options. 
 
The camera settings include exposure time, global gain, color gains, Gamma, 
saturation, hue, brightness, contrast, image orientations, and light source 
temperature. For more details please refer to respective commands that set 
these parameters. 
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The capture options include frame averaging, decimation, where to store the 
captured images and so on. For more details please refer to the Capture Options 
sub-pane. 
 
Equivalent Commands 
 
1 Shortcuts 
 

 Double-click the live preview image window that is displaying video to 
initiate an image capture.  The resulting camera image will be stored 
directly to file, into the field group, or both places based on the settings 
selected.  If the option to preview the captured image is selected, then the 
resulting camera image will be opened in a new window. 

 

 Hold down the <Ctrl> key and press G on the keyboard to Grab an image 
from the camera 

 

 An icon with the picture of a camera is present in the Standard toolbar 

and can be clicked to capture an image 
 
2 From Capture Control Sub-Pane 

 

 
 

 

Push to acquire an image from the camera 
based on the present camera settings and 
capture options. 

 
Camera presets include averaging and 
decimation options. If a preset, for example 
400 X Fluorescent, is selected, the camera 
will be directed invoke the settings recorded 
in that preset. The Capture Options Sub-
Pane will be updated to synchronize with the 
current setting.   
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3 From Capture Options Sub-Pane 
 

 
 

 

Select the number of frames to be averaged. If 
1 is selected, no frame averaging will be 
performed. If a value of 2 is selected, two 
successive frames will be summed and then 
divided by two to create the intermediate image 
that is the input to subsequent post-capture 
processing. 4 and 8 are similarly defined. 
 
Frame averaging reduces noise. If n frames are 
averaged, the energy of the noise will be 1/n of 
its original level. 
 
Frame averaging is performed only when 
capturing full field of view. 
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Sub-sample the output image. If 1 is selected, 
no sub-sampling will be done. If 2 is selected, 
the number of columns and number of rows of 
the image will be reduced by a factor of two by 
merging every two consecutive columns and 
rows. 3 and 4 are similarly defined. 
 
The way INFINITY ANALYZE performs 
subsampling also helps to avoid aliasing. 
 
Subsampling is available only when capturing 
full field of view. 
 
Pixel-Shift Cameras 
 
Pixel-shifting cameras such as INFINITYX-21 
and INFINITYX-32 shift the sensor position from 
the original location.  Use this option to specify 
the pixel shifting steps to use when completing 
an image capture.  
 

 

Select the destinations of the acquired image. If 
File is selected, the image will be stored to disk 
under that file path specified below. If Field 
Group is selected, the image will be appended 
to Field Group if there is still room. If Both is 
selected, the image will be stored as a file on 
disk and also appended to Field Group. 

 
Show the file name to be used when the 
acquired image is to store on disk. A new file 
name may be entered directly. 

 
Push to bring out a File Save As dialog to 
specify the file name to be used when the 
acquired image is to store on disk. 

 If checked, the image of the full field view will be 
captured regardless of the preview state. If 
unchecked, only the image that is being 
previewed will be captured. This can be a sub-
region of the full field of view, or lower-resolution 
image which INFINITY ANALYZE is using for 
display purpose. 

 If checked, a new image window will be created 
to load a copy of the acquired image. 

 If checked and the captured image is to store in 
a file, a File Save As dialog will be brought up 
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after each image is acquired. The file name 
contained in the dialog is initially set to the 
previously specified file name such as 
“e:\report\specimen.jpg”. 
However, it is free to change the file name, or 
instruct INFINITY ANALYZE not to save this 
image at all. 

 If checked and the acquired image is to store in 
a file, the file name will be changed by INFINITY 
ANALYZE after the current image has been 
saved. The new file name will be used for the 
next acquired image. The new file name will 
have an integer appended to the original text 
and this integer will be incremented by one each 
time a new file name is generated by INFINITY 
ANALYZE. 

 Available when Capture to File option is 
selected and Capture full field of view. The 
camera output will be set to 10, 12, or 14-bit, 
based on the sensor capabilities.  The output 
file format is TIFF.  

 

When checked, the captured image will use the 
exposure time and camera gain specified in the 
field (ms = milliseconds), instead of the current 
exposure time being used for the live preview.  
This option would typically be used in low light 
applications, where exposure times must be 
much longer for image capture, than would be 
available for a live preview.  The live preview 
would be used for framing and focusing under 
bright light, then the lamp source would be 
switched to the reduced illumination and a long-
exposure image would be obtained using the 
Capture button. 

 

The dropdown list and Add / Remove buttons 
are used to allow the application to store and 
retrieve commonly used Exposure / Gain 
combinations, for convenience 

 
4 From Settings File 
 
Upon start-up, INFINITY ANALYZE automatically loads and applies the capture 
options used last time. The capture options, and many other options and 
settings, are specific to each camera and are stored in a file that is uniquely 
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identifiable by the serial number of the camera. When INFINITY ANALYZE exits, 
it automatically updates the file. 

 

3.2.2.2 Capture Video 

 
Introduced initially in release 6.4.1, ANALYZE provides the ability to capture 
short video clips directly from within the application.  The performance of this 
function depends heavily on the computer performance and on the write speed of 
the chosen storage device.  A video compression is applied to the video clip 
capture process, with a common default compression codec being identified by 
default.  An option is provided on the Help -> Settings dialog, to specify an 
alternate compression codec, if there is a reliable alternative codec configured on 
your PC.  There is no mechanism available through INFINITY ANALYZE to valid 
the performance of any video compression codec. 
 
The captured AVI file is stored in the folder location specified for captured images 
under the Capture Options sub-pane.  The currently identified filename prefix for 
image capture will be used for the AVI filename, but the file type will be AVI.  
Ensure that „Auto increment file name‟ is selected in the Capture Options sub-
pane, to prevent any new video clip overwriting the previously recorded file. 
 
INFINITY ANALYZE does not include the ability to play back a video clip or AVI 
file.  It is necessary to locate the saved AVI file on disk and send the file to a 
suitable video player software. 

 
Equivalent Commands 
 
From Time Lapse Sub-Pane 
 

 
 

 
Click the Video Capture button to initiate a video clip 
acquisition. 
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Click on the same button to stop the video clip 
acquisition. 

 A counter increments the number of seconds of 
recorded video 

 

Click this icon to open a folder browser window 
showing the entire contents of the Image Capture 
folder location.  Use this window to locate recently 
recorded video clips.  Right mouse click on the AVI 
file and choose your preferred video player to send 
the video clip to. 

 

3.2.2.3 Multispectral Capture 

 
A capability introduced in release 6.5.0, the Multispectral Capture uses a wizard-type 
interface to facilitate the acquisition of multiple images collected using various filters or 
fluorescence cubes, to produce a color composite result. 

 
Note: The Multispectral Capture function is unavailable until at least one 
fluorophore / spectral channel has been entered into the Multispectral 
Settings table – see following section for details. 

 
The Multispectral Wizard appears on screen as a stand-alone dialog which provides a 
workflow presented as two separate stages: acquisition and composition.  The functions 
and checkboxes that are available differ, depending on which stage is active.  It is 
possible to switch back and forth between the two stages to manipulate the outcome of 
the composite result. 
 

Note: During the Multispectral Capture process, the updates from the 
camera to the standard live preview window are suspended.  If the focus 
is diverted from the Wizard dialog, the live preview window will show an 
icon that indicates it is unavailable.  When the Wizard window is closed, 
the live preview will resume updating automatically. 

 
The acquisition stage is intended to facilitate the process of acquiring two or more 
images that are tinted according to their excitation, or the color produced by the filter 
cube.  The workflow process allows for easy preview and capture of each channel in the 
selected sequence.  The desired exposure time and gain to use for each channel image 
can be entered manually or adjusted using the controls.  The application remembers the 
settings used for each channel, so that the next composite image should be even easier 
to acquire if the relative brightness of each stain and/or sample remain the consistent. 
 
Additional acquisition methods have been added to the Multispectral Capture wizard 
with release 6.5.2 to streamline performance.  The wizard now provides the choice of 
acquiring frames using one of these three techniques: (a) Normal, (b) Unity Gain, (c) 
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Exposure Simulation.  To select which acquisition method is used by the Wizard, visit 
the Help  Settings menu, and activate the Multispectral Capture Wizard tab.  Use this 
settings menu to also control whether the image acquisition is to be performed with the 
camera output set to 8-bit or 16-bit mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Mode Description 

Normal The exposure time and gain adjustments entered in the 
wizard for each channel are used for the image 
acquisition.  When the live update is active, the image 
acquisition is taken directly from the live update stream. 
When the preview window is static (ie. Following an 
initial image capture – when the green triangle play icon 
is displayed to the right of the Capture button), exposure 
or gain may be adjusted and a new image captured, 
without the need to resume the live update, if desired.  
However, there will be a delay equivalent to a frame 
capture time, when the live update is not active. 

Unity Gain The exposure time is entered in the field to facilitate fast 
refresh of the live update window.  Then the gain setting 
is increased to produce an image of sufficient 
brightness.  The pixel noise in the image will increase 
significantly with larger gain values.  When the capture 
button is pressed, the gain will be automatically returned 
to unity (value=1.0), and the wizard calculates an 
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appropriate exposure time to use such that the captured 
image will match the intensity shown in the live update, 
but without the pixel noise produced by an extended 
gain.  The advantage of this technique is that the user 
can dynamically control the base exposure to maintain a 
faster image refresh rate in the live update.  The 
disadvantage is that the only gain setting available for 
acquisition is 1.0.  

Exposure Simulation Using the Maximum Exposure parameter (specified on 
the Help  Settings panel) for the live update, the 
wizard simulates the result of a longer exposure time 
selected by the user, by digitally amplifying the a 
records.  When the capture button is pressed, the 
exposure time indicated in the field is used as an actual 
exposure time for the acquisition.  This method allows 
the user to dynamically use gain settings other than 1.0 
for the acquisition, and provides the benefit of keeping 
the live update exposure times shorter to ensure frame 
rates that are faster than the acquisition exposure time 
would allow.  For example, if a maximum exposure 
setting of 200 ms is entered on the Help  Settings 
panel, then the camera will be able to deliver live 
updates at speeds up to 5 fps – even though the 
exposure simulation may show the image brightness as 
if a 1500 ms exposure was in effect.  The captured 
image will actually use a 1500ms exposure, while the 
live update is using a 200ms exposure that has been 
digitally amplified to simulate the 1500ms result. 

Maximum 
actual exposure time 

The numerical value entered into this field will identify 
the exposure time value (in ms) that will be used as the 
maximum used by the live update.  By limiting the actual 
exposure time with this value, it means that the camera 
frame rate can remain responsive for focus and framing 
adjustments, while the exposure simulation is used to 
show how the captured image will appear.  Using values 
of 100ms, 200ms, or 500ms, will result in the camera 
delivering frame rates of 10, 5, or 2 fps, respectively. 

Image bit depth Specify either 8-bit or 16-bit.  Selecting the 16-bit mode 
will enable the camera to output whichever maximum bit 
depth it supports: 10, 12, or 14-bit. 

 
When the Image bit depth is set to 16-bit, the Multispectral Capture Wizard will present 
an option on the Composite window, to enable the results to be saved in 16-bit mode, if 
TIF is chosen as the output file type.  When the Image bit depth is constrained to 8-bit, 
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there may be a slight performance increase with shorter exposure times, but the option 
to save images in 16-bit mode is removed from the Wizard. 
 
The Multispectral Capture Wizard must be stopped and re-started for adjustments made 
on the Settings dialog to take effect.  The currently active acquisition mode is displayed 
in the title bar of the Multispectral Capture Wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Three mechanisms are provided to facilitate the 
specification of exposure time.  Either type a 
numerical value directly into the text box, or use 
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the up/down arrows, or use the slide bar.  The 
up/down arrow controls will increment or 
decrement differently, depending whether the 
exposure time is below 100ms, between 100 
and 1000ms or above 1000ms.  The slider 
control is linear, so it is difficult to use it for fine 
adjustments in the lower part of the exposure 
range. 

 

The gain value can be specified by typing the 
numeric value directly into the text box, or by 
using the up/down arrow controls. 

 
Note:  

The exposure / Gain controls are capable of 
operating in three distinct modes, controlled by a 
setting in the Help -> Settings menu dialog.  The 
default mode is a standard exposure / gain 
where the camera uses the values as entered. 
The Unity Gain mode allows the operator to 
specify any desired gain value for the live 
update, but when an image is acquired the gain 
will be reset to 1.0 and a calculated equivalent 
exposure time will be used to produce an image 
as bright as in the live update.  The remaining 
capture mode is the Exposure Simulation mode.  
When active in this mode, the camera will not 
exceed the specified exposure time for the live 
update, but will implement a digital intensity 
stretch, until the acquisition is requested.  At that 
time an image is acquired using the equivalent 
real exposure time. 

 

The Capture button will freeze the live update 
window and copy the acquired image into the 
thumbnail view for the active channel.  Make any 
desired alterations to the exposure or gain and 
press the Capture button again to use the new 
settings and acquire a new image. 

 

With a captured image displayed in the main 
window, the Capture button remains available, 
but a „play‟ button icon appears to its right.  Click 
on this icon to resume live updates in the main 
window. 

 
Use the Open File button to load a previously 
captured image into the wizard and apply the tint 
associated with this channel.  This operation 
allows for already processed images to be used 
as part of the composition – for example a Z-
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stack or MFC-processed image can be loaded. 

 When checked, the current channel will not be 
used as part of the composite result.  The 
thumbnail window will show the most recently 
acquired frame, but there will be a horizontal line 
drawn across the middle of it. 

 
When checked, the tint identified for this channel 
will not be applied to the live update or the 
captured image displayed in the main window 

 When checked, the wizard enables the 
suppression of auto-fluorescence or hides low-
end noise in the image with a black-level offset.  
This process clips all values below a selected 
output level by setting them to zero.  The 
amount of black-level adjustment can be set 
manually, or can be determined by the 
application using the „Auto‟ button. 

 When checked, the wizard enables the 
enhancement of the image contents by 
increasing intensity levels based on a specified 
white point.  This process is used to brighten a 
dark scene by stretching the output values from 
the selected point on the histogram up to the 
saturation point.  The amount of the stretch can 
be set manually or can be determined by the 
application using the „Auto‟ function. 

 

Calculate suitable black-level and white-level 
positions on the histogram for the active 
channel. 

 
Returns the black-level and white-level offset 
markers to their base positions at either side of 
the histogram. 

 

Histogram window shows the distribution of 
pixels across the intensity range and allows for 
the black-level and white-level markers to be 
manually dragged to new positions.  Images 
from color or monochrome values are displayed 
as RGB24 bitmaps in the live update, and the 
application allows for the manipulation of each of 
the Red, Green, and Blue histograms 
individually, if desired. To manipulate the two 
marker positions, click the mouse on either bar 
and drag it left or right.  The two markers cannot 
cross, so the black-level marker will always be to 
the left of the white-level marker 
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This dropdown menu determines the input 
channel from a color camera (R,G,B) that is 
used to acquire the image, unless „Treat as 
monochrome‟ is checked. This setting also 
selects the current input channel that is being 
manipulated with histogram adjustments.  

 
When a color camera is detected, this checkbox 
option is presented, but for a monochrome 
camera it is hidden.  When checked, the 
captured image uses output from all three 
(R,G,B) channels, improving the ability to detect 
color emissions in the wavelengths between 
blue & green (cyan), and between green & red 
(yellow). 

  
This control shows the color tint to be applied to 
the acquired image.  It displays the display color 
that is associated with the current channel 
specification.  It can be clicked to reveal a color 
palette for selecting an alternate color.  The 
chosen color will be remembered for this 
channel.  If the originally defined color choice is 
desired, the „return‟ arrow icon will restore it. 

 
Use either the zoom slider control or the text box 
to type in value to be used for the live update or 
captured image display in the main window.   

 

If the separate color channels do no align 
spatially, then the X & Y shift can be used to 
adjust the alignment of this channel within the 
composite.  These offset values are stored 
between sessions, and must be reset manually. 

 

The number of thumbnail panels displayed in the 
bottom of the wizard window matches the list of 
active channels to use that are identified in the 
Multispectral Settings dialog, and are presented 
in the same order.  A mouse click on the 
thumbnail results in the wizard focus returning to 
the selected channel, and the control functions 
can be used to manipulate the image settings. 

 

The composite result will be displayed in the 
thumbnail when it is generated. 

 
Use the „< Back‟ option to step back to the 
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previous channel in the sequence 

 
Use the „Next >‟ option to step forward to the 
subsequent channel in the sequence 

 
This button will result in the wizard terminating.  
A warning prompt will appear if images have 
been acquired but not saved.   

 
 

The composition stage of the process displays some different functions in the dialog.  
This stage appears when either the Next button has been pressed following the 
acquisition of each channel, or when the Composite thumbnail window is clicked 
 
The options and controls that appear in the composition stage of the wizard differ 
slightly from those present when the individual images are active as part of the 
acquisition stage.  The explanations provided below only apply to the controls that are 
unique to the final screen of the wizard. 
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Press this button to produce a composite 
image of the channels acquired.  Once a 
composite has been generated during a 
session, it is updated automatically each 
time an input channel is altered.  
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Once two or more channel images have 
been acquired, it is possible to produce a 
composite.  Use either the „Next >‟ button, 
or click on the Composite thumbnail to 
review the composite result and access 
the controls presented. 

 
Click this button to display a standard 
Windows dialog where the folder location, 
filename and file type are specified.  If the 
option for „16-bit mode for channels‟ is 
checked, the file type is restricted to TIF 
format 

 
To preserve the full range of camera 
output in the resulting images, enable this 
option and the composite and captured 
channels will be saved in TIF format.  
None of the formats of JPG, BMP, or SIF 
can support 16-bit output. 

 When this option is checked, the save 
function will only store the composite and 
the input channel files will be discarded.  
By default, this option is un-checked such 
that the composite and all input channels 
are stored using a naming convention that 
associates all channels with the composite 
result. 

 If checked, the wizard will clear the current 
channels and resume a new sequence 
starting at the first channel when the 
operation is finished.  When this option is 
un-checked, the launch of a new session 
is done using the toolbar icon or the menu 

 
Terminates the current wizard session.  If 
acquired images have not been saved, a 
warning dialog will appear.  If the 
checkbox to „Start new Multispectral 
Capture sequence‟ is enabled, then the 
Wizard will re-launch.  

 
  
Equivalent Commands 
 

1 The Standard toolbar includes an icon that will launch the Multspectral Capture 
wizard.   
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3.2.2.4 Multispectral Settings 

 
The Multispectral Settings dialog is an integral part of the Multispectral Capture 
capability introduced with release 6.5.0.  It is used to establish a list of fluorophores or 
multispectral acquisition channels by creating a personal list of named channels and 
specifying the color tint that is to be applied to that channel.  This tool also allows for the 
selection of which channels are actively being used, and the sequence in which they 
should be acquired within the wizard.   
 
The dialog includes the ability to sort the list, to work with an estimated emissions color, 
to include a wide field channel, and to save or load an existing list of fluorophores. 
 

 
 

 
The Sequence column is populated automatically and 
identifies the number of entries stored in the Settings list 

 
The Fluorophore column is user-specified and contains 
the reference name for the fluorophore being used.  The 
text defined in this column appears nowhere else in the 
application. 

 
Enter an excitation wavelength (number in nm) for the 
fluorphore.  This is only a reference value.  It has no 
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impact on the outcome 

 
Enter the emissions wavelength (number in nm) for the 
fluorphore.  This value is only a reference but is used to 
provide an approximate emission color in the adjacent 
field in the table to act as a guideline.   

 
This field will display a color based on the numeric 
wavelength value in the previous column.  The displayed 
color may not appear to be exactly representative of the 
color seen in the microscope eyepieces, since the monitor 
settings will impact the actual color displayed. 

 
Enter a text string that will be used in the wizard to identify 
the input channel by name. 

 
This field will display the color tint applied to this channel 
when acquired in the Multispectral wizard.  Click on the 
dropdown indicator to display a color selection palette 

 

The color selection palette is used to choose the specific 
tint to apply to the specific fluorophore.  Select from one of 
the colors presented, or click on the More… option for an 
expanded selection.  An option is presented in the palette 
to allow for the selection of the approximate emissions 
color, if desired. 

 

The final column in the table is used to identify whether 
the individual channel is to be used by the wizard during 
acquisition.  Many channels may be specified in this table 
at any given time, but only the ones identified with a 
checkbox in the „Use‟ column will be prompted for in the 
wizard.  The channels containing a checkbox do not need 
to be sequential rows in the table, but the order of 
acquisition will be from top to bottom – using only the 
rows identified with the checkbox in this column.  

 
Press „OK‟ to exit this dialog and store the results 
automatically. 

 
Press „Cancel‟ to close the dialog without saving any 
changes made during this edit session. 

 
Use the „Load‟ button to display a standard Windows file 
dialog.  Browse to the folder to locate a previously saved 
channel file.  Loading an already defined list of 
fluorphores can save time for new users. 

 
Use the „Save‟ button to display a standard Windows file 
dialog.  Browse to a folder where the currently defined list 
of fluorphores can be saved into a channels file.  Save 
your defined fluorphore names and tint specifications to 
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create a back-up or share them with other users. 

 

The number of channels with the checkbox in the „Use‟ 
column is shown in the right side of the dialog.  If the list 
of defined fluorphores spans more than one screen, refer 
to this counter to ensure that only the desired number of 
channels are selected. 

 
Click this button to generate a new row in the table of 
settings 

 
This button adds a special wide field definition to the list of 
channels.  A wide field channel definition is optional, but 
has a limited set of controls along the row. 

 
This button will automatically turn on the „Use‟ checkbox 
for all rows in the settings table  

 
This button will automatically disable the „Use‟ checkbox 
for all rows in the settings table 

 

Use either the up or down arrow to reposition an active 
row in the table.  The order of channels appearing in the 
Multispectral Capture wizard follows the sequence used in 
the table from top to bottom – only referencing the rows 
tagged with the „Use‟ flag.  To specify that specific 
channel appears ahead of another in the Capture wizard, 
place it in a higher position in this table using the arrow 
buttons.  Only the highlighted row will move up or down in 
the list when these buttons are selected.  

 
 
Equivalent Commands 
 

1 The Standard toolbar includes an icon that will launch open the Multspectral 
Settings dialog.   

 

3.2.3 Auto Exposure 

 
Use the Auto Exposure command to have the application determine an appropriate 
integration time to deliver an image of acceptable brightness from the INFINITY 
Camera.  It may be necessary to select this option more than once, as the application 
restricts itself to performing several iterations of exposure time adjustment in an attempt 
to reach a suitable brightness.  Selecting this option a second time may refine the 
selection of the integration time. 

3.2.4 White Balance 

Use the White Balance command to enable the color reproduction from the camera to 
match the current illumination source and optical filters. 
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The color correction is based on the visible portion of the live images. For the best 
results, it is advised to perform white balance when imaging a white (gray or colorless) 
and bright (but not saturated) object. This command initiates a one-push effort to 
reproduce the right colors. It might be necessary to repeat the process until the 
desirable state is reached. 
 
Equivalent Commands 
 

1 From Settings File 
 
Upon start-up, INFINITY ANALYZE automatically loads and applies the camera 
color correction settings used last time. These settings, and many others, are 
specific to each camera and are stored in a file that is uniquely identifiable by the 
serial number of the camera. When INFINITY ANALYZE exits, it automatically 
updates the settings file.  Note that the camera responds differently to variations 
in lighting levels and choice of optical filters.  It may be necessary to adjust the 
exposure time and white balance if there are alterations in the lighting conditions. 
 
2 From Capture Control Sub-Pane 
 

 
 

  
Camera presets include 
camera color correction 
settings. If a preset, for 
example 400 X Fluorescent, is 
selected, the camera will be 
directed to amplify each color 
channel of the video stream 
by respective parameters 
recorded in that preset.   

When White Balance button is 
pressed, INFINITY ANALYZE 
examines the most recently 
grabbed frame and adjusts 
the color channel gains of the 
camera in an effort to 
reproduce the colors in the 
best way. The preset will be 
deselected to reflect the 
change.  
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3.2.5 Grey Point 

 
Use the Grey Point command to correct a color imbalance in the active captured image 
or to adjust the color channel gains in the camera‟s live preview (same as Area WB). 
 
Correction of color reproduction is based on the values of a small rectangular 
neighbourhood of pixels. These pixels should be colorless but instead are showing a 
tint. INFINITY ANALYZE will calculate the relative strength of each color component 
and adjust the color gains accordingly. 
 
Click a pixel within the active image to indicate to INFINITY ANALYZE the centre of the 
neighbourhood on which color correction will be based.  
 
If the active image window is displaying live images from the camera, this command 
performs area based white balance for the camera. 
 
Equivalent Commands 

 
From Camera Control Sub-Pane 

 
 

 
Push to perform white balance based on a small rectangle 
within the visible portion of the live image. The operation is 
completed by a click on the live image, which specified the 
center of the rectangle on which the white balance will be 
based. The width and height of the rectangle is the smallest 
region of interest that is supported by the camera. 

 

3.2.6 Manual White Balance 

 
Use the Manual White Balance command to adjust the gain setting used on each color 
channel to manipulate the color output of the camera.  This feature can be used to fine 
tune the color appearance of the camera image, when necessary. 
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The 

individual slider controls allow for the increase or reduction of the amount of color 
channel gain that is applied to each of the channels on the sensor.  Small variations 
made to the values displayed can have a significant impact on the color of the live 
preview and captured images.  The values presented when this dialog opens are 
representative of the current color channel gains set on the camera, whether resulting 
from a White Balance operation or from an earlier manual adjustment. 

3.2.7 Light Source 

 
Use the Light Source command to tune the color reproduction of the camera. 
 
The same object may appear slightly different in color under different lighting conditions. 
The reason for this change in camera response is due to the light source itself, which 
can have varied chromatic content, called temperature.  It is measured in Kelvin. When 
describing a light source as having a Kelvin rating, it refers to a light source that emits 
energy across the entire visible range from 300nm to 700nm. Sunlight and incandescent 
lamps fit to this model conveniently. However, all fluorescent and discharge lamps have 
interrupted spectra, where Kelvin temperature is only used in a loose sense to describe 
wavelength distributions of the light sources.  
 
 
 

Light Source Kelvin 

DAYLIGHT Clear Blue Sky 8000 to 27000 

Rainy, Misty Daylight 7200 to 8500 

Overcast Daylight 6500 to 7200 
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Direct Sun + Clear Blue Sky 5700 to 6500 

Summer Sunlight (9am to 3pm) 5400 to 5700 

Summer Sunlight (before 9am or after 3pm) 4900 to 5600 

Electronic Flash (Typical) 6200 to 6800 

ARC LAMP Xenon Arc (unfiltered) 6000 

White Flame Carbon Arc 5000 

Yellow Flame Carbon Arc 3200 

FLUORESCENT LAMP 'True Daylight' Color Match Tubes 6500 

'Daylight' Cool White Tubes 4300 

'Warm White' Tubes 3000 

TUNGSTEN LAMP Photoflood & 3400K Tungsten-Halogen 3400 

Tungsten-Halogen and Photo Lamps 3200 

Projection Lamps (500 to 1000 Watts) 2900 to 3000 

General Purpose Lamps (200 to 500 Watts) 2900 

Household Lamps (100 to 150 Watts) 2850 

Household Lamps (60 Watts) 2800 

Household Lamps (40 Watts) 2750 

CANDLE Standard Candle 2000 

Candle Flame 1500 

 
 
The camera itself or INFINITY ANALYZE cannot possibly determine the temperature of 
the light source from live images alone and has to rely on user input to generate the 
digital image that best matches human perception.  
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 Select to indicate to INFINITY ANALYZE that the 
light source has an interrupted spectrum. 

 Select to indicate to INFINITY ANALYZE to add 
more red. 

 Select to indicate to INFINITY ANALYZE to add 
even more red. 

 Select to indicate to INFINITY ANALYZE to add 
more blue. 

 Select to indicate to INFINITY ANALYZE to add 
more red and blue. 

 Select to indicate to INFINITY ANALYZE no color 
temperature should be incorporated in image 
formation. 

 
 
Equivalent Commands 
 

1 From Settings File 
 
Upon start-up, INFINITY ANALYZE automatically loads and applies the light 
source color temperature setting used last time. The color temperature setting, 
and many other settings, are specific to each camera and are stored in a file that 
is uniquely identifiable by the serial number of the camera. When INFINITY 
ANALYZE exits, it automatically updates the settings file. 
 
2 From Capture Control Sub-Pane 
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Camera presets include light source setting. If a preset, for example 400 X 
Fluorescent, is selected, the camera will be directed to modify the directly 
captured image to add a tint typical of objects illuminated with a light source 
of a temperature recorded in that preset. The Light Source Sub-Pane will be 
updated to synchronize with the current settings.   

 
 
3 From Light Source Sub-Pane 
 

 
 

 Select to indicate to INFINITY ANALYZE that the light 
source has an interrupted spectrum. 

 Select to indicate to INFINITY ANALYZE to add more red. 

 Select to indicate to INFINITY ANALYZE to add even more 
red. 

 Select to indicate to INFINITY ANALYZE to add more blue. 

 Select to indicate to INFINITY ANALYZE to add more red 
and blue. 

 Select to indicate to INFINITY ANALYZE no color 
temperature should be incorporated in image formation. 
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3.2.8 Bitmap Overlay 

Any predefined bitmap image can be combined with the live preview or to images as 
they are captured.  The size and content of the bitmap overlay files is defined by the 
operator.  They can be selected and loaded from anywhere on the accessible network.  
Bitmap overlay files are often used to provide an alignment guideline or an approximate 
scale reference.  
 
Choose from a selection of bitmap overlay images provided within the INFINITY 
installation, in a folder named “reticles”.  Alternately, create your own bitmap overlay to 
match the size and scale desired.  Image editing programs such as MS Paint can be 
used to generate a custom bitmap.  Any region of the bitmap image that is set to pure 
white (R=255, G=255, B=255), will be mapped to transparent when the bitmap is 
loaded, while any other color combination will appear as the opaque color specified, 
 
Use the options presented in the dialog panel to control the position of the bitmap with 
reference to the live preview image.  Additional options identify whether the selected 
bitmap file is to be displayed in the live preview and/or on the captured image. 
 
Clicking on the File button on this panel will display a file selection dialog allowing for 
the location and filename of an existing bitmap image to be identified. 
 

 

3.2.9 Crosshairs 

Enable the Crosshair feature to display a small overlay in the center of the live preview 
image.  This indicator shows the geographic center of the camera output.  As the live 
preview window is zoomed or panned, the crosshair graphic remains aligned with the 
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center coordinates of the full image resolution.  This tool is designed as a quick 
reference for alignment purposes only, and does not get transferred into the captured 
image. 

3.2.10 Subsampled 

This option is unavailable for several CCD-equipped camera models (INFINITY2, 
INFINITY3, & INFINITY4.  For the INFINITY1 camera series and the INFINITY2-2 
camera model, enabling this function results in a faster frame rate output from the 
camera by reducing the number of pixels used for the live preview.  The sub-sampling 
factor of 2 is applied to retain the overall field of view, and adjusting the zoom to retain 
the appearance of a full resolution image.  The image quality of the live preview is 
reduced when this function is enabled.  If this function is enabled, it only affects the live 
preview. 

3.2.11 Stretch Histogram 

This utility represents a shortcut to the built-in Look-Up Table (LUT) function within 
INFINITY ANALYZE.  It will apply a quick LUT enhancement to the live video preview 
for times when a low light image is being used to configure the camera for longer 
exposure captures.  As an example, it would be applicable to enable this feature when 
using the live preview to frame and focus on a fluorescence sample under low lamp 
intensity, to avoid photo-bleaching.   
 
It quickly sets an automatic histogram stretch via the LUT function in both the live 
preview and captured images.   To disable the histogram stretch, return to the File 
menu and select the option a second time.   An alternate method to revert to an un-
stretched display is to simply click on the LUT enable / disable button in the Histogram 
auxiliary window.   Refer to the next section for Look-Up Table controls. 
 
Equivalent Commands 
 

1 The histogram auxiliary window includes an icon that can toggle the Stretch 
Histogram function.   

 

3.2.12 2x2 Binned 

In release 6.5.0, the camera binning function is not available. 
 

3.2.13 Lookup Table 

 
The Lookup Table function provides access to the dynamic lookup table controls.  The 
functionality of the controls is explained in detail in section 2.2.4 on the histogram pane. 
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Enable / Disable the LUT on the Live Image 

 Reset the active LUT channel  

 Open the LUT editing dialog 

 Make the Red channel active 

 Make the Green channel active 

 Make the Blue channel active 

 Activate all three channels 

 

3.3 The Edit Menu 

 
INFINITY ANALYZE maintains a processing history for each image. The processing 
history is a chain of internal buffers holding the states of the image. A new state of the 
image is automatically created and appended to the processing history after each 
operation that has modified that image. Viewing an image in different ways, 
measurement in progress (not yet completed) and annotating an image (before the 
annotation objects are burned into images) are not considered as modifying an image. 
 

3.3.1 Undo 

 
Use the Undo command to reverse the most recent action that has modified the image. 
The possible number of undo steps is the length of processing history.  
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3.3.2 Redo 

 
Use the Redo command to undo an Undo operation. 
 

3.3.3 Copy to Clipboard 

 
Use the Copy to Clipboard command to convert a copy of the active image to Windows 
Bitmap format and place it on the clipboard. 
 

3.3.4 Abort 

Use the Edit -> Abort function to cancel the current cursor select / action mode.  For 
example, when using the Annotate -> Select functions, the cursor remains in an active 
selection mode, until the process is cancelled by the Edit -> Abort option. 
 

3.4 The View Menu 

 
The commands in this group are used to customize the appearance of user interface 
elements, images and computer screen. 
 

3.4.1 Toolbars and Auxiliary Windows 

 
Use the Toolbars and Auxiliary Windows commands to toggle the visibility of each 
toolbar or auxiliary window. 
 

Toolbar Auxiliary Window 

Standard Control Panel 

Image Processing Help Desk 

Image Measurement Database 

Image Annotation Measurement 

 Histogram 

 
A toolbar can be either visible or hidden. When it is visible, it can be either docked or 
floating. The menu can also be docked or floating, although it cannot be hidden. 
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Drag its grip to adjust the position of a toolbar or the menu. Double-click on its grip to 
toggle the dock state of a toolbar or the menu.  
 
Control Panel can be visible or hidden. However, it is always docked to the left side of 
the main window. Control Panel can be resized but cannot be floating or docked to any 
other side of the main window. 
 
The other auxiliary windows can be either visible or hidden. When they are visible, they 
can be either docked or floating. Drag their captions to adjust their positions. Double-
click on their captions to toggle their dock states. 
 

3.4.2 Status Bar 

 
Use the Status Bar command to toggle the visibility of the status bar. 
 

3.4.3 Auxiliary Window Captions 

 
Use the Auxiliary Window Captions command to turn on or off the Windows Themes on 
all the auxiliary windows. 
 
INFINITY ANALYZE is able to draw the captions of the auxiliary windows in its own way 
but also accepts Windows Themes for its auxiliary windows. If Auxiliary Window 
Captions is unchecked as is the default, INFINITY ANALYZE will draw the captions of 
auxiliary windows in its own way which in a sense is more convenient to use. However, 
if Auxiliary Window Captions is checked, INFINITY ANALYZE will draw the captions of 
auxiliary windows according to the current Windows Themes. 
 
This command merely affects the appearance of the auxiliary windows and does not 
limit their functionalities. 
 

3.4.4 Image Window Size 

 
The Image Window dimensions option can be used to specify the width and height of 
the current preview window.  The dimensions of the display window for the live preview 
or any captured images can be specified manually using the Image Window Size dialog.  
To control the output dimensions for captured or saved images refer to the section 
describing the Adjust -> Crop option.  
 



  Lumenera INFINITY ANALYZE 
Release 6.5.3   User’s Manual 

Copyright  2006-2016  Page 65 

 
 

3.4.5 Image Window Tabs 

 
Use the Image Window Tabs command to toggle the visibility of image window tabs. 
 
Image windows can have or have not tabs. When an image window has a tab, the tab 
can either appear on top or at bottom of the main window. Choose Image Window Tabs 
to hide the tabs if the image windows currently have tabs. Choose Image Window Tabs 
to show the tabs if the image windows currently do not have tabs. 
 
Equivalent Commands 
 
Image Window Tab Context Menu 
 
Use Hide Tabs to remove image window tabs currently shown in the main window. 

 

3.4.6 Centre 

 
Use the Centre command to place the centre of the image at the centre of the image 
window. 
 

3.4.7 Corner 

 
Use the Corner commands to place a corner of the image at the centre of the image 
window. 
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3.4.8 Fit to Window 

 
Use the Fit to Window command to toggle between browsing and focusing mode of 
image display. 
 
In browsing mode, the full field of view is visible, albeit possibly in a reduced resolution. 
In focusing mode, maximum image details are shown, although the field of view may be 
reduced to a sub-window.  The image display is in focusing mode whenever scroll bars 
are provided along the bottom edge and right side of the image.  
 
Browsing mode is best for finding the right field of view to capture. Focusing mode is 
best for a rapid response to focus adjustments. 
 
Equivalent Commands 
 
Use the icon in the Standard Toolbar to quickly fit the current image to the dimensions 
of the active window. 
 

 
Adjust the zoom of the image such to be able to 
see the entire image within the window 

 
 

3.4.9 Zoom In and Out 

 
The options presented in this menu area are to provide specific zoom levels, if desired.  
It is possible to control the zoom level of the live preview and any captured image using 
the zoom slider in the Standard Toolbar, or a scroll-wheel on the mouse when over the 
image window. 
 

 
Manually adjust the zoom level of the image  

 
Type a value or select an entry from the dropdown 
list to control the zoom.  This field displays the 
current zoom level of the window 

The current zoom level is displayed in the Status Bar, when enabled (from the View 
menu).  This menu item provides a preset list of popular zoom levels to change the 
display if the currently active window. 
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3.4.10 Zoom Preview 

 
Use the Zoom Preview command to toggle the visibility of the zoom preview window. 
 

 
 
 
 
The zoom preview window is a floating window launched by INFINITY ANALYZE upon 
request. It magnifies a small region of an image. The magnification rate is adjustable 
with the slider at the bottom of the zoom preview window. The zoom preview window 
works on both still image and live image. The magnified region is centered around the 
current mouse position.  Close the Zoom Preview dialog when desired, using the “X” in 
the upper right corner. 
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3.4.11 Full Screen 

This feature allows for the maximum amount of screen real-estate to be dedicated to the 
display of the live preview and/or captured images.  All elements of the INFINITY 
ANALYZE user interface are suppressed with the exception of the Menu bar along the 
top.  Use the maximize button in any image window to enlarge the display to fit the 
entire screen.  The <Esc> key can be used to toggle in & out of Full Screen mode.  
Alternately, the View menu is available to choose display options that will enable or 
disable other menu controls, and this includes the Simple Mode, and Enable All layout 
options. 
 

3.4.12 Screen Gamma 

 
Use the Screen Gamma command to adjust the Gamma of the computer screen, if 
necessary.  For most computer monitors, specifically flat panel displays, the value on 
this dialog should be left at 1. 
 

 
 

 
Use the slider to set a new Gamma value. 

 The minimal allowable screen Gamma, corresponding to the physical 
value 0.01. 

 
The current screen Gamma, scaled up by 100. 

 The maximal allowable screen Gamma, corresponding to the physical 
value 4. 

 
Push to dismiss the dialog and keep the screen Gamma setting. 

 
Push to dismiss the dialog and discard any modification to screen 
Gamma made during the dialog. 

 

 

Equivalent Commands 
 
1 From Settings File 
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Upon start-up INFINITY ANALYZE will load the screen Gamma setting used last time. 
Upon exit INFINITY ANALYZE will store the screen Gamma value to a private settings 
file. 
 
2 From Help > Settings 
 
Any change made to screen Gamma will be shown when this dialog is open. Any 
change made to screen Gamma during this dialog will be effective when INFINITY 
ANALYZE runs next time. 
 

3.4.13 Language 

 
The interface for the INFINITY ANALYZE application can be displayed in a number of 
different languages.  The available language files are provided in the installation folder 
where the application resides, in a sub-folder called Language.  When the application 
starts it detects each language file from the folder and presents it for selection under the 
Language field in the View menu.  All menu and dialog text is displayed using the 
Language file, based on a referenced index numbering system, allowing straight-
forward translation possible for most languages. 
 
The Help Desk auxiliary window text messages are supplied in English only.  However, 
there is a sub-folder created for each language, located under the folder “Guide”, where 
the INFINITY ANALYZE application is installed.  To change the Help Desk text, 
translate the contents of each of the HTML document files under the language of 
choice.  When the Language option is changed from the View menu, the Help Desk files 
are pulled from the equivalent language Guide folder. 
 
Contact the Lumenera Technical Assistance Centre (TAC) team 
[support@lumenera.com] for additional information on the Language file support.  If you 
do not see a language file that suits your preference, the support team can provide you 
with instructions to use when translating the menus and messages to produce your own 
customized interface. 
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3.5 The Database Menu 

 
A full-featured database system has been built into INFINITY ANALYZE. The database 
is accessible whenever INFINITY ANALYZE is running. All the information content of an 
image, together with its quantitative result of measurement, date of creation, author, and 
textual description may be archived in the built-in database. 
 
INFINITY ANALYZE uses a caption to uniquely identify each record in the database. 
User specifies a caption for each image that is being stored to database. Besides the 
caption, there are three other fields in each record. Date is the time of creation of the 
record. Author is the name of the operator that has captured or processed the image. 
Description is a single line of text usually explaining the image or the measurement 
performed over the image. 
 
When a new record is created for an image, the quantitative result of any measurement 
done so far for the image, as shown in the auxiliary window Measurement, will also be 
saved to database. 
 
The built-in database is fully controlled from the corresponding auxiliary window. The 
menu duplicates some of the more frequently used commands. 
 

3.5.1 Store 

 
Use the Store command to save the active image and its measurement result to the 
built-in database. 
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Specify a caption for the record to 
create. Must be a single line of text. 
The title of the active image is initially 
displayed but it is free to specify a 
different one. The caption should be 
unique within the database. Otherwise 
a warning message appears as shown 
below. Answer Yes to replace the 
existing record with the same caption. 
Answer No to abort the storing 
operation. 
 

 

 

Specify the date of creation of the 
record. The date initially shown is that 
of the computer. Click to pick up 
another date as illustrated below. 

A 
date may also be entered directly. 

 

Specify the name of the person who is 
responsible for the acquisition, 
processing or measurement of the 
active image. Must be a single line of 
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text. 

 

Specify a single line of text as a note, 
remark or comment. 

 

Push to add the new record to 
database. 

 Push to exit the dialog and do not 
modify the database. 

 

3.5.2 Load 

 
Use the Load command to open the selected record in the database. 
 
Note that a record in the database must have been selected for this command to work. 
Otherwise a warning message will appear as the following. 
 

 
 
When a record is successfully loaded, a new image window will be created to hold the 
image data from that record. If the image has been measured before, measurement 
information will also be loaded into the auxiliary window Measurement. 
 

3.5.3 Delete 

 
Use the Delete command to delete the selected records in the database. 
 
For this command to work, at lease one record has to be selected. Otherwise, the 
following warning message appears. 
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A deleted recorded cannot be restored. 
 

3.5.4 Refresh 

 
Use the Refresh command to reset the record list to its default state. 
 
Upon start-up, the auxiliary window Database shows the most recently added records, 
up to 100 entries. After a query has been made on the database, the auxiliary window 
Database shows the query result. Choose Refresh to list the records in order of their 
creation.  

3.6 The Field Menu 

 
The Field Group of INFINITY ANALYZE is a buffer of images with a thumbnail displayed 
for each image. Field Group can be a destination of acquired images. Images in Field 
Group can also act as the input to a multi-operand image processing operation. 
 
The Field Group is a complementary means of image organization. While an image in 
an Image Window can be more readily viewed or processed, the Field Group provides 
the concept and infrastructure of an ordered set of images. INFINITY ANALYZE has a 
mechanism for exchanging data between Field Group and Image Window. 
 

3.6.1 Open 

 
Use the Open command to load images from a Field Group File (*.fov). 
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A Field Group File (*.fov) is a file format used to hold the content of the Field Group. 
Successfully loaded images from a Field Group file will be appended to the Field Group. 
Note that images in Field Group File are also properly ordered as in the Field Group, so 
the successfully loaded images will be appended to the Field Group in that order. 
 

3.6.2 Save 

 
Use the Save command to store the content of Field Group to a Field Group File (*.fov). 
 
A Field Group File (*.fov) is a file format used to hold the content of the Field Group. 
 

3.6.3 Import 

 
Use the Import command to load image files to Field Group. 
 
This command is capable of opening multiple image files, subject to the conditions that 
these files reside in the same folder and are in the same format. The acceptable file 
formats are listed below. 
 

Windows Bitmap *.bmp  

JPEG *.jpg  

TIFF *.tif Load first page only. 

Portable Network Graphics *.png  

3.6.4 Export 

 
Use the Export command to save images in Field Group to disk. 
 
The images in the Field Group will be saved in turn. For each image a File Save As 
dialog is open with a default file name. It is possible to change file name, format and 
location on disk separately for each image. The acceptable file formats are listed below. 
 

Windows Bitmap *.bmp  

Independent JPEG Group *.jpg Least compression applied. 

TIFF *.tif Save as single page. 

Portable Network Graphics *.png  

 

3.6.5 Append 

 
Use the Append command to add the active image to the end of Field Group. 
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The Field Group is limited in both pre-allocated memory and number of thumbnails. 
When there is no room for another image, the Append command fails quietly. 
 
The Field Group retains all information of the image, including metrical and 
magnification settings. 
 
Equivalent Command 
 
Double-click within the active image window. 
 

3.6.6 Load 

 
Use the Load command to open the selected image in Field Group. 
 
A new image window will be created to hold a copy of the image in Field Group. The 
image in Field Group will not be removed. 
 
Equivalent Command 
 
Double-click within the thumbnail of the image in Field Group. 
 
 
Selecting an image in Field Group 
 
1 Click within the thumbnail. 
2. Hover over the thumbnail for 2 or more seconds. 
 

3.6.7 Move Up 

 
Use the Move Up command to swap the selected image in Field Group with the 
preceding one. 
 
Equivalent Command 
 
Right click the thumbnail to bring up Field Group Context Menu, and choose Move Up. 
 
Selecting an image in Field Group 
 
1 Click the thumbnail. 
2. Hover over the thumbnail for 2 or more seconds. 
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3.6.8 Move Down 

 
Use the Move Down command to swap the selected image in Field Group with the 
following one. 
 
Equivalent Command 
 
Right click the thumbnail to bring up Field Group Context Menu, and choose Move 
Down. 
 
Selecting an image in Field Group 
 
1 Click the thumbnail. 
2. Hover over the thumbnail for 2 or more seconds. 
 

3.6.9 Clear 

 
Use the Clear command to remove the selected image from the Field Group. 
 
Equivalent Command 
 
Right click the thumbnail to bring up Field Group Context Menu, and choose Clear. 
 
Selecting an image in Field Group 
 
1 Click the thumbnail. 
2. Hover over the thumbnail for 2 or more seconds. 
 

3.6.10 Clear All 

 
Use the Clear All command to empty the Field Group. 
 
Equivalent Command 
 
Right click the thumbnail to bring up Field Group Context Menu, and choose Clear All. 
 
Selecting an image in Field Group 
 
1 Click the thumbnail. 
2. Hover over the thumbnail for 2 or more seconds. 
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3.6.11 Show Previous 

 
Use the Show Previous command to display the currently selected image of Field Group 
in the active image window and then select the preceding image in Field Group. 
 
For this command to work, the selected image in the Field Group must have the same 
numbers of columns and rows of pixels and number of color channels as the active 
image, otherwise, the command fails quietly but the internal index will be decremented, 
so next time the command is executed it can find the right image to display. 
 
The Show Previous command replaces the image in the active image window by the 
selected image in the Field Group. Note that only pictorial data are replaced and the 
other layers such as graphical overly are kept intact. This facilitates the comparing of 
multiple images. 
 

3.6.12 Show Next 

 
Use the Show Next command to display the currently selected image of Field Group in 
the active image window and then select the following image in Field Group. 
 
For this command to work, the selected image in the Field Group must have the same 
numbers of columns and rows of pixels and number of color channels as the active 
image, otherwise, the command fails quietly but the internal index will be incremented, 
so next time the command is executed it can find the right image to display. 
 
The Show Next command replaces the image in the active image window by the 
selected image in the Field Group. Note that only pictorial data are replaced and the 
other layers such as graphical overly are kept intact. This facilitates the comparing of 
multiple images. 
 

3.6.13 Panorama  

 
Use the Panorama command to stitch multiple rows or columns of images together. 
 
The images to stitch must be stored in the Field 
Group, and ordered correctly. Images can be captured 
from the live preview and sent directly to the Field 
Group, or images can be collected in advance and 
opened into the Field Group.  The Capture Options 
dialog controls how captured images are directed into 
the Field Group. 
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All images in the Field Group will be used in the operation.  Images must be stored in 
the Field Group in sequence such that each image overlaps the one before.  For each 
adjacent image, there must be greater than a 50% overlap with the previous image. At 
least two valid images must be in the Field Group. 
 
The process supports the creation of a Panorama result with 
images collected horizontally, vertically, or in both axes, so 
long as there is at least a 50% overlap with the adjacent 
image, in the sequence that they are stored in the Field 
Group. 
 
Initiate the Panorama operation by selection it from the Field 
drop-down menu. 
 
A new image window will be created to hold the output 
panorama image. Images will be combined with matching 
performed along the overlap areas.  In some cases changes 
to image intensity may make the joins between adjacent 
images more visible.  It is best to disable Continuous Auto 
Exposure during the acquisition of images intended for a 
panorama stitching operation.   
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Images can be stitched from a horizontal orientation, from a vertical orientation, or by 
combining both horizontal and vertical adjustments.  As long as the images are stored in 
the Field Group in a sequence such that they share at least a 50% overlap with the 
adjacent image, the algorithm will find the matching areas and perform the stitching.  
The image below provides one example of how images could be collected in a valid 
sequence for stitching, where the numbers in the upper left corners of each frame 
indicate the sequence of storage in the Field Group. 
 
 

 
 
 

3.6.14 Multi-Focus Composition 

 
Multi-Focus Composition is included for demonstration purposes in the initial INFINITY 
ANALYZE application package.  Any processing performed using this feature will 
include a permanent „EVALUATION‟ watermark in the resulting image.  This feature is 
enabled through the purchase of the Advanced Features package (part: LuIAP-2).  
Contact a Lumenera Scientific Sales account manager for more information. 
 
Use the Multi-Focus Composition command to create a best focused image from 
partially focused images in Field Group.  The number of images that can be held in the 
Field Group at one time is controlled using an option in the Help Settings dialog. 
 
The partially focused images, at least two, must have been cached in Field Group. All 
images in Field Group will contribute to the focus of the output image. These input 
images must be identical in the numbers of columns and rows of pixels and the number 
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of color channels, and should be acquired in sequence either from bottom to top, or top 
to bottom with respect to focus depth. 
 
For the multi-focus composition to work, the active image must also have the same 
number of columns and rows of pixels and the same number of color channels. When 
the computation starts, the active image will be replaced by the first image in the field 
group. As the following images in field group are aligned and fused with the previous 
ones, the active image will be replaced by the current state of the focus combination. 
 
There are two concatenated stages of multi-focus composition. The first stage is the 
registration of the two adjacent images and the second stage is the fusion of two 
images. The registration is the process to correct the image displacement. It is used 
only when imaging with stereomicroscopes. The fusion is the heart of multi-focus 
composition and is common to all types of microscopy.  
 

 
 
The Multi-Focus Composition command performs the merging operation on images in 
the Field Group. For images acquired from compound microscopes (with vertical 
objectives), simply select the menu item  Field Multi-Focus Composition to invoke the 
process.  
 
To fuse images acquired from stereomicroscopes, an additional step is required prior to 
the image merging, to align the images by removing the shift introduced by the optics.  
Choose the menu item Field  Shift Correction for Stereomicroscope as a one-time 
operation any set of images collected into the Field Group.  Once this process has 
completed, the images are ready to be fused using the  Field Multi-Focus 
Composition. 

 
A new image window will be created to hold the output image. The output image has the 
same metrical and magnification settings as those of the first image in the Field Group. 
 
The example below illustrates the process. The two images on the left are the first and 
the last of a stack of 29 images gathered over the same field of view, and the image on 
the right is the fusion of the image stack. 
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3.6.15 Math 

 
 
Combine command: 
 
Use the Combine command to compose a color image from the last three images in the 
Field Group. 
 
The last three images are assumed to be the red, green and blue channels of a color 
image. As such, they must be identical in the numbers of columns and rows of pixels. It 
is not required that these images are all color or all monochrome. If a color image is in 
place, only its first channel, i.e. red, will be extracted. 
 
A new image window will be created to hold the output image. The output image has the 
same metric and magnification setting as those of the last image in the Field Group. 
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Split command: 
 
Use the Split command to decompose a color image into three monochrome images 
representing its red, green and blue channels. 
 
The output images are appended to the Field Group. 
 
Add command: 
 
Use the Add command to sum together the images within the Field Group. 
 
Subtract command: 
 
Use the Subtract command to subtract the active image from each image in Field 
Group. 
 
For this command to work, each image in the Field Group must have the same numbers 
of columns and rows of pixels and number of color channels as those of the active 
image. The output images will replace those corresponding images in the Field Group. 
Negative pixel values are truncated to zero. 
 
Divide command: 
 
Use the Divide command to divide each image in Field Group by the active image. 
 
For this command to work, each image in the Field Group must have the same numbers 
of columns and rows of pixels and number of color channels as those of the active 
image. The output images will replace those corresponding images in the Field Group. If 
there is a zero pixel in the active image this command fails quietly. The output image 
will be scaled in intensity to make it approximately the same brightness as those of the 
input images.  
 
Max command: 
 
Use the Max command to create a pixel-wise channel-wise maximal value image from 
all images in the Field Group. 
 
For this command to work, all images in Field Group must be identical in the numbers of 
columns and rows of pixels and the number of color channels, and there must be at 
least two images in the Field Group. 
 
A new image window will be created to hold the output image. The output image has the 
same numbers of columns and rows of pixels and the same number of color channels. 
The value of each color component (channel) of each pixel of the output image is set as 
the greatest of all corresponding values from all images in the Field Group. 
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The output image has the same sampling intervals and magnification setting as those of 
the first image in the Field Group.  
 
Min command: 
 
Use the Min command to create a pixel-wise channel-wise minimal value image from all 
images in the Field Group. 
 
For this command to work, all images in Field Group must be identical in the numbers of 
columns and rows of pixels and the number of color channels, and there must be at 
least two images in the Field Group. 
 
A new image window will be created to hold the output image. The output image has the 
same numbers of columns and rows of pixels and the same number of color channels. 
The value of each color component (channel) of each pixel of the output image is set as 
the least of all corresponding values from all images in the Field Group. 
 
The output image has the same sampling intervals and magnification setting as those of 
the first image in the Field Group.  
 
The example below illustrates the process. The first image is pure green simulating a 
microscope filter. The second image is a raw image captured for a specimen. The third 
image is the output of the Min operation with the previous two images as input. 
 

   
 
 
Average command: 
 
Use the Average command to create a pixel-wise channel-wise mean value image from 
all images in the Field Group. 
 
For this command to work, all images in Field Group must be identical in the numbers of 
columns and rows of pixels and the number of color channels, and there must be at 
least two images in the Field Group. 
 
A new image window will be created to hold the output image. The output image has the 
same numbers of columns and rows of pixels and the same number of color channels. 
The value of each color component (channel) of each pixel of the output image is set as 
the mean of all corresponding values from all images in the Field Group. 
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The output image has the same sampling intervals and magnification setting as those of 
the first image in the Field Group.  
 
 

3.6.16 Color Composition 

 
Color composition is provided within INFINITY ANALYZE primarily to allow for multiple 
monochrome images to be assembled together to produce a false-color composite.  
This type of technique is commonly used when working with fluorescent images, but 
can be effectively applied under other circumstances to produce a range of stimulating 
results. 
 
Within INFINITY ANALYZE the tools are available to select any (R,G,B) channel as 
input from an existing image stored in the field group, and to assign it to any (R,G,B) 
output in the resulting color composite image. 
 
Source images can be captured directly from an INFINITY camera, or can be opened as 
image files captured from another source. Each image must be added to the Field 
Group before proceeding. 
 
With the source images already in the Field Group, it is necessary to leave at least one 
image open in the Working area of ANALYZE, to act as the “container” for the resulting 
combined image. 
 

 
 
Channel Selection 
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The channel selection specifies which of the three output channels is active. The Red, 
Green, and Blue buttons are used to exclusively indicate the output channel where the 
source image is directed, and the channel which is being manipulated at any given time. 
 
Assign Input Source 
The next step is to assign an input source to the Red output channel. The dropdown 
dialog box identifies every image loaded in the Field Group, and lists each image as 
three channels. (Note: even monochrome images are represented as R,G,B channels – 
in a monochrome image all three channels contain identical pixel values.) 
 
Each image is identified in sequence as they are loaded into the Field Group. Observe 
the repetition of each term for Field #, with a separate line identifying the Red, Green, 
and Blue Channels. 
 
The button labelled as Re-load from Field Group is used to refresh the original source 
channel at any time. Use this button to undo any manipulation that produced an 
undesirable result. 
 
Display Mode 
The display mode controls how the manipulated channel results are portrayed during 
the process. These exclusive button choices are used to indicate the preference for how 
the image is displayed. 
 

Composite shows the full output result of combining all three input channels (R, 
G, B). As the manipulation steps progress, a composite result will show a full 
color image of the interim results. 
Channel Monochrome shows the results of a manipulation on an individual image 
channel. Only the results being applied to the current input Channel Selection are 
shown, and they are displayed as a monochrome result only. 
 
Channel Color shows the results of the manipulation on the current input Channel 
Selection. The result is displayed in the input Channel Selection color. 

 
Preset Adjustments 
Several pre-defined image manipulation tools have been incorporated into the Color 
Composition utility. Each button performs a specific alteration to the image data stored 
in the currently active channel, and the resulting effect is reflected in the histogram 
display area (see below), as well as in the output image. 
 
The slider control and accompanying text box work together with the Set as Constant 
button. This optional adjustment can be used in place of an input image channel, if the 
desired output requires a specific flat field of color to be injected. The scale range is 
from 0 to 255, where 0 represents black and 255 represents white. For example, this 
function can be used to set the Blue channel to a mid-range value of 128, adding a blue 
cast to the resulting color composition. 
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Using either the slider control or typing in a numerical value directly is a matter of 
personal preference.  
 
The four buttons labelled as Log, Exp, Span, and Invert will apply a specific 
enhancement to the image intensity values in the current input channel, and display the 
results. Log and Exp are logarithmic and exponential histogram adjustments. Span is 
equivalent to a linear histogram stretch where minimum intensity data is mapped to zero 
while the maximum intensity is set to 255, and all values between the min and max 
input are spaced equally. The Invert adjustment simply reverses bright and dark values 
in the image by reversing the minimum and maximum, and all values in between. 
 

 
 
Note: Manipulations performed on an input image channel are cumulative. Selecting a 
second button to manipulate the input source image will result in the transformation 
being applied against the results of the first transformation. Either using a different 
operation, or repeating the same operation will apply further histogram manipulations to 
the results of the previous operation. To test the impact of each of the operations on a 
single channel, it is necessary to use the button Re-load from Field Group to reset the 
image to its original condition prior to selecting a different operation. 
 
Reset and Apply LUT 

The Reset LUT operation sets the histogram manipulation back to its default setting. 
This is represented by a 45 degree slope line from the lower left corner to the upper 
right corner of the histogram box. The Apply LUT button is used to see the results of 
applying a modified histogram manipulation to the currently active image channel. 
 
Look-Up Table (LUT) manipulations work the same way as for the Histogram Look-Up 
Table controls.  Look-Up Table (LUT) is the term used to describe this type of histogram 
manipulations, where the input image has intensity values for each pixel in the range of 
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0 to 255, and the LUT defines a resulting output intensity value to re-assign to each 
pixel. On the graphic LUT window, the horizontal scale identifies the input image range 
with 0 (black) on the left and 255 (white) on the right. For the corresponding output 
intensity values, the LUT displays a range of 0 (black) at the bottom, and 255 
(white) at the top. 
 
The manipulation of the LUT is done graphically by adjusting the handles using the 
mouse. The graph is divided into three segments. Click the mouse in between the two 
handles to move the center section of the LUT, keeping the handles locked relative to 
each other while. Click the mouse anywhere along the line between a corner and the 
nearest handle to change move the relative position of that handle while leaving the 
other one anchored. 
 
Save LUT & Load LUT 
Use the Save and Load buttons to store a copy of a specific channel look-up table. 
When a color composition result has been obtained, and the same transformation is to 
be applied to other input images in the future, the LUT should be saved. The LUT is 
saved for the currently active channel. Ensure that a naming convention is used to 
enable the LUT to be identified with each channel when it is later loaded from disk. 
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3.7 The Adjust Menu 

3.7.1 Image Gamma 

 
Use the Image Gamma command to adjust the Gamma of the active, captured, image. 
This menu item is inactive when the active window holds the live preview 
 

 
 

 
Use the slider to specify a factor to be multiplied to the original Gamma of 
the active image. 

 The minimal allowable multiplier. 

 Show the current factor being multiplied to the original Gamma of the 
active image. A value can also be entered directly. 

 The maximal allowable multiplier. 

 
Push to dismiss the dialog and finalize the modification to the Gamma of 
the active image. 

 
Push to dismiss the dialog and discard any modification to the active 
image. 

 
 

3.7.2 Grey Point 

This function performs an area-based white balance adjustment on either a live preview 
window, or as a post-processing alteration to a captured image.  Once selected, the 
mouse pointer changes to an eye-dropper icon when the mouse is over the active 
window.  The camera color channel gains, or the color balance on the captured image 
are adjusted based on a calculation of white balance determined from the pixel values 
in the area around the mouse click location.  Use the eye-dropper location to specify a 
region that represents a grey or white area in the image, regardless of the actual color 
tint of that area.  The image appearance is adjusted based on the selected target. 
 

3.7.3 Interactive 
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Use the Interactive command to adjust the intensity, saturation and hue of the active 
image or the camera. 
 

 
 
 

 
Indicate the intensity of the image is being adjusted. The intensity of a pixel 
is in the range [0,255]. Values out of the range will be truncated. 

 Indicate the saturation of the image is being adjusted. The saturation of a 
pixel is in the range [0,255]. Values out of the range will be truncated. 

 
Indicate the hue of the image is being adjusted. The hue of a pixel is in the 
range [0,255] and is cyclic with a period of 256. 

 
Use the slider to adjust a color component.  

 Minimal allowable amount that can be added to a color component. 

 Show the current amount that is being added to a certain color component 
of all pixels. A value may be entered directly. 

 Maximal allowable amount that can be added to a color component. 

 
Push to close the dialog and finalize the adjustments to the active image. 

 
Push to close the dialog and discard any modification to the active image. 

 
 

3.7.4 More 

 
Use the More commands to increment, by a predefined amount, the intensity, saturation 
or hue of the active image or the camera. 
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When the active image is an empty image and is being used to display video streams, 
the commands increment the gain, saturation and hue settings of the presently 
connected camera instead of the intensity, saturation and hue of a still image. 
 
The amount of change for each color channel may be specified by the Increments 
command. 
 

3.7.5 Less 

 
Use the Less commands to decrement, by a predefined amount, the intensity, 
saturation or hue of the active image or the camera. 
 
When the active image is an empty image and is being used to display video streams, 
the commands decrement the gain, saturation and hue settings of the presently 
connected camera instead of the intensity, saturation and hue of a still image. 
 
The amount of change for each color channel may be specified by the Increments 
command. 
 

3.7.6 Increments 

 
Use the Increments command to set the amount of change made by More and Less 
commands. 
 

 
 

 

 Still Image Live Image 

 
The intensity of a pixel is 
in the range [0,255]. 
Values out of the range 
will be truncated. 

The range of applicable gain values 
is specific to each model of camera. 
The increment of gain is proportional 
to that of the intensity of a still image. 

 
The saturation of a pixel The saturation of a camera is in the 
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is in the range [0,255]. 
Values out of the range 
will be truncated. 

range [0, 2]. The increment of 
saturation of the camera is 
proportional to that of a still image. 

 
The hue of a pixel is in 
the range [0,255] and is 
cyclic with a period of 
256. 

The hue of a camera is in the range [-
180, 180]. The increment of hue of 
the camera is proportional to that of 
the hue of a still image. 

 Push to dismiss the dialog and commit the new settings. 

 
Push to dismiss the dialog and discard any changes. 

 

3.7.7 Mirror 

 
Use the Mirror commands to flip the active image. 
 
When the active image window is showing the video, the command actually flips the live 
images. 
 

3.7.8 Rotate 

Use the Rotate commands to rotate the active, captured image. 
 

3.7.9 Crop 

The crop function allows for a Region of Interest (ROI) to be specified in the live preview 
image or on a captured image.  Selecting this menu item results in the cursor changing 
shape, indicating that a drag operation is required in an active window.  The drag 
operation defines the initial ROI area.  Once this has been defined,  a graphic box with 
text fields provides the ability to override position and size of this initial ROI.   
 

 
 
 
 
Use the fields on the corners of the rectangle to make any desired adjustments to the 
initial ROI.  The upper left and lower right corner coordinates for the ROI can be 
adjusted or the ROI width and height fields can be used.  Each time a value is adjusted 
the ROI size and position is re-displayed accordingly, and related fields are altered. 
 

Note:  A limitation is imposed on the performance of the crop function 
for the INFINITY3-3UR, INFINITY3-6UR, and INFINITY3S-1UR 
camera models.  Any crop region will be automatically centered on 
the sensor.  Only the width and height of the ROI can be adjusted, not 
the position. 
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The chosen ROI dimensions can be positioned in the center of the image sensor by 
choosing the option checkbox for centering, 
 
Choose to either leave the region outside the ROI as the original image data, or have 
this area hidden under an opaque mask, by enabling or disabling the Mask check box, 
and selecting the desired color from the dropdown.  Only the live preview ROI specified 
is updated when the Crop function is active, while the image area outside the ROI 
remains frozen in time showing the way the image was at the moment the ROI was 
activated. 
 
 
 

 
 
 
 
The final option on this dialog can be selected to enable repetitive use of the same ROI 
dimensions next time.  Selecting this option overrides the initial step of dragging the ROI 
on the active image.  Instead, the Crop dialog is immediately displayed with the last 
used dimensions, as soon as the Adjust -> Crop function is selected. 
 
The Crop feature can be used to accelerate the process of focusing on a sample in the 
live preview, by causing the camera‟s frame rate to increase by extracting only an ROI 
from the camera.  Creative use of the crop function can result in several rectangular 
areas being shown on the live preview from different instances in time. 
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Disabling the „Capture full field of view‟ setting on the Capture Options pane will result in 
a captured image having the same dimensions as the crop area.  The crop region will 
be ignored if the „Capture full field of view‟ is enabled. 
 
When used on a captured image, the crop function will define an ROI that will be used 
when saving the image.  For example, if it important to produce a saved image file that 
is 800 x 600, from a 1.4 megapixel image (full resolution 1392 x 1040), the crop function 
allows for defining the exact size and positioning the ROI for maximum effect. 
 

3.7.10 Reset Crop 

Click on the Reset Crop menu function to clear a currently defined ROI in the currently 
active window. 
 

3.7.11 Magnification and Units 

 
Use the Magnification command to synchronize calibration with objective switching, if 
desired.  The most accurate method to use for measurements with different objectives 
is to perform a calibration operation using each objective, and to store the calibration 
data using a named Preset.  However, if desired, the Magnification and Units option can 
be used to alter the current calibration settings without performing another calibration 
step. 
 
For correct measurement and printing, INFINITY ANALYZE needs to know the sampling 
intervals and magnification of the digital image. Horizontal sampling interval, vertical 
sampling interval and magnification comprise a micrometer. Each image acquired with 
INFINITY ANALYZE has a micrometer associated with it. This micrometer is the basis 
of correct measurement and printing. When an image is being captured, the system 
micrometer is duplicated and set as the micrometer of that image.  
 
The process that sets up the system micrometer is referred to as calibration. In the 
simplest sense, calibration could be performed for a single objective, combined with the 
use of the Magnification command to adapt the calibration for different objectives or 
magnifications. A successful calibration will correctly setup the sampling intervals and 
magnification for use with that objective. When a new objective and/or some other 
intermediate lenses are in place, the Magnification command records the updated 
magnification and scales the sampling intervals accordingly. 
 
This dialog can be used to apply the active calibration to an image not originally 
acquired with a preset, or stored in a format other than the native „.SIF‟ type.  If the 
objective magnification used to acquire the image is an exact match for the calibration 
preset, then this technique can be used to assign a calibration to an image.  Options on 
the dialog panel allow for the calibration to be applied to all images that are currently 
open within INFINITY ANALYZE, or all images that have been imported/captured into 
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the Field Group.  Care must be taken to ensure that the current calibration preset is 
applicable to every open / Field Group image, prior to selecting the OK button.  Use the 
Cancel button if there is any uncertainty about the objective magnification that was 
being used when any image being processed was originally acquired. 

 
 

 
 

 
The present internal sampling interval, in 
microns per pixel, kept in system 
micrometer. 

 
The abbreviation to use for linear 
measurement and the relationship 
between the preferred linear 
measurement units and the defined 
sampling interval, in microns, stored in 
system micrometer. 

 
The abbreviation to represent the 
measurement units for area 

 
The present numerical value for 
magnification kept in system micrometer. 
The new magnification should be entered 
here. 

 
Push to dismiss the dialog. The newly 
entered magnification will be accepted 
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and the sampling intervals will be scaled 
accordingly. 

 
Push to dismiss the dialog and discard 
any change to system micrometer. 

 

Designate whether the currently selected 
calibration is to be applied to all open 
images, all images in the Field Group, or 
only the active image (no checkbox 
active). 

 

3.8 The Enhance Menu 

 

3.8.1 Flatfield Correction 

 
Use the Flatfield Correction command to filter the active image to make appear as if 
having been evenly illuminated. 
 
The example below illustrates the process. 
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3.8.2 Flatfield Correction Options 

 
Use the Flatfield Correction Options command to customize the filter employed in 
Flatfield Correction. 
 

 
 

 
The support of the Gaussian filter that will be 
used to detect illumination distribution. 
Intuitively, it is the radius, in pixels, of the 
biggest circle within which illumination 
remains even. The default value 31 should 
work well in most cases. A greater value may 
be specified if the illumination is flatter. A 
smaller value may be specified if the 
illumination varies more abruptly. 

 
Push to dismiss the dialog and update the 
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parameter for use with Flatfield Correction. 

 
Push to dismiss the dialog and keep the 
original parameter of Flatfield Correction. 

 

3.8.3 Denoise 

 
Use the Denoise command to suppress noise in the active image. 
 
The example below illustrates the process. 
 

 
 

 

3.8.4 Remove Bad Pixels 

 
Use the Remove Bad Pixels command to detect and make up malfunctioning pixels. 
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The example below illustrates the process. The first image is captured with a camera 
having defective pixels. The second image is result of the operation. The third image is 
the result of the command executed twice. 
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3.8.5 Unsharp 

 
Use the Unsharp command to do the generalized unsharp mask filtering for the active 
image. 
 
The example below illustrates the process. 
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3.8.6 Unsharp Options 

 
Use the Unsharp Options command to set up parameters for Unsharp. 
 
Unsharp masking is a traditional film compositing technique used to sharpen edges in 
and improve the contrast of an image. INFINITY ANALYZE generalizes this technique 
to make it more powerful. The generalized unsharp masking, also known as latitude 
reduction, uses a Gaussian filter to separate an image into two images, one is the low-
frequency part, called background image, and the other is the high-frequency part, 
called contrast image. The background image, representing the latitude or dynamic 
range of the image, may be reduced by multiplying a coefficient smaller than unity. 
Latitude reduction actually improves the contrast without enhancing noise. If the image 
is free of noise, the contrast image may also be multiplied by a coefficient greater than 
unity to augment contrast in a straightforward manner. This process is referred to as 
high boost. Finally there is a visual psychology factor to be considered. Boosted 
contrast in dark areas of an image may be interpreted as noise. To make the processed 
image appear natural, the intensities of background image pixels can be used as 
weights when the contrast image is being added back to the background image to form 
the output image of the latitude reduction operation. The process of adding contrast 
image to the background image is called back-projection. 
 
 

 
 
 

 
Controls the size of the Gaussian filter in pixels 
to separate the active image into background 
and contrast. 

 
The coefficient by which the background image 
will be multiplied. 0.5 corresponds to latitude 
reduction by 1 bit. 0.25 corresponds to latitude 
reduction by 2 bits. Any value may be entered 
here. However, if a number greater than 1 is 
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given, the contrast of the image will be 
decreased. 

 
The coefficient by which the contrast image will 
be multiplied. Any value may be entered here. 
However, if a number smaller than 1 is given, 
the image will be smoothed. 

 
Specify how the background image and 
contrast image are combined. Valid values are 
in the range [0, 1]. If 0 is entered, the 
background image and the contrast image will 
be simply added. If 1 is entered, only the 
brightest pixels of the background image will be 
modified by adding corresponding pixels from 
the contrast image. The parameter determines 
the dependency of back-projection on 
background image. 

 
Push to dismiss the dialog and keep the 
parameters for Unsharp. 

 
Push to dismiss the dialog and discard any 
change to parameters for Unsharp. 

 
 

3.8.7 Max Contrast 

 
Use the Max Contrast command to linearly scale the intensities of the active image so 
that they span the whole dynamic range. 
 
The following two images, together with their histograms, illustrate the process. 
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3.8.8 Sketch 

 
Use the Sketch to generate a pencil drawing from the active image. 
 
The example below illustrates the process. 
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3.8.9 Adaptive Edge Emphasis 

 
Use the Adaptive Edge Emphasis to enhance edges in the active image. 
 
The example below illustrates the process. 
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3.8.10 Equalization 

 
Use the Equalization command to manipulate the histogram of the active image to make 
it as flat as possible. 
 
The following two images, together with their histograms, illustrate the process. 
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3.8.11 Amplitude Depletion 

 
Use the Amplitude Depletion command to extract the texture of the active image. 
 
The example below illustrates the process. 
 

 
 

 
 

3.8.12 Darkfield Simulation 

 
Use the Darkfield Simulation command to generate a darkfield representation of a 
brightfield image. 
 
The example below illustrates the process. 
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3.8.13 Photometric Transform 

 
Use the Photometric Transform commands to generate a grayscale or inverted 
representation of the active image. 
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The Monochrome command removes color information from the active image and 
leaves only intensity information, as shown below. 
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The Negative command reverses the lookup table of the active image to produce an 
image that is complementary in color with the original image, as shown below. 

 
 

 
 

3.8.14 Spherical Aberration Correction 

 
Spherical Aberration Correction is included for demonstration purposes in the standard 
INFINITY ANALYZE application package.  Any processing performed using this feature 
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will include a permanent „EVALUATION‟ watermark in the resulting image.  This feature 
is enabled through the purchase of the Advanced Features package.  Contact a 
Lumenera Scientific Sales account manager for more information. 
 
Use the Spherical Aberration Correction to reduce the haze over the active image due 
to spherical aberration of the optical system. 
 
The example below illustrates the process. 
 

 
 

 
 
 

3.8.15 Spherical Aberration Correction Options 

 
Use the Spherical Aberration Correction Options command to specify to what degree 
the spherical aberration will be corrected. 
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Note:  If you prefer that the live preview window remains active during 
a measurement operation in the preview window, see the option on the 
Help  Settings dialog that will enable this feature. 
 

 
 
There is only one parameter to control the spherical aberration correction. Acceptable 
values for this parameter are in the range [1, 200]. Setting the parameter to a number 
less than 100 will cause haze to be removed from the image. Setting the parameter to a 
number greater than 100 will smooth the image.  
 

3.9 The Measure Menu 

 
Measuring operations within INFINITY ANALYZE generate one, two or three pieces of 
output information. Each operation produces a graphic result in the overlay layer of the 
image. Most operations also create textual annotation objects describing the 
quantitative outcome of the measuring operations, and entries in the table of the 
auxiliary window Measurement holding the quantities. 
 
All measurements rely on the Calibration that is currently active, either where a 
calibration step has been completed recently, or the calibration is enabled by activating 
a stored Preset. 
 
Measurement operations can be performed on a captured image, or on a live preview.  
A live preview image will temporarily cease being updated while measurement 
operations are being performed.  This allows for accurate measurements to be taken of 
non-stationary objects.  As soon as the current measurement operation is terminated, 
the live preview will resume updating.  
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Note:  During a point-to-point measurement, the cursor movement 
can be constrained in either the vertical or horizontal direction from 
the start location.  Holding down the shift key allows for only vertical 
movement, while holding down the ctrl key will allow for only 
horizontal movement. 

The graphical output of a measuring operation is placed as a special annotation object, 
and the textual output of a measuring operation is a text annotation object. The 
graphical box for the text is scaled to contain the text at the specified font size for 
display when Fit to Window is disabled.  If the image is currently displayed with Fit to 
Window enabled, then the text is displayed at an enlarged size to make it more legible, 
even though it may be extended beyond the dimensions of the graphical box.  The text 
will be scaled to fit within the box when the annotations are burned into the final image. 
 
The quantitative output of a measuring operation is one or more new entries in the 
auxiliary window Measurement. Each entry or record has three fields, the first field is the 
name of the command that has generated the entry, the second field is the parameter 
that is being measured, and the third field is the numerical result of the measurement 
operation. 
 
If some measurement has been done for an image, the measurement results will also 
be saved when the image is stored to the database. When the image is again loaded 
from the database, the previous measurement results will also be loaded. 

3.9.1 Point to Point 

 
Use the Point to Point command to measure the distance between two points or two 
parallel lines. 
 
Click to specify two points. After the first click a rubber band with two perpendicular legs 
is being drawn to connect the first point and the current mouse position. Use the legs to 
align with parallel lines. The second click ends the measurement. 
 

 
 
 
 
 
 
The Point to Point measurement will be placed on the overlay layer of the image. A 
short description showing the distance will appear in a text box annotation object. A new 
entry will be appended to the auxiliary window Measurement to hold the value of the 
distance. 
 
The example below illustrates the process. 
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3.9.2 Area Perimeter 

 
Use the Area Perimeter command to measure the area and perimeter of a closed 
shape. 
 
The closed shape is created by freehand drawing, i.e. moving the mouse while pressing 
down left mouse button. Release the left mouse button to signify the end of drawing. 
The starting point, i.e. where left button is pressed, and the ending point, i.e. where the 
left button is released, remain connected automatically during the drag operation, and 
the shape will be closed by this straight line when the mouse button is released. 
 
The drawing will be put on the overlay layer of the image. A short text describing the 
measured area and perimeter will appear in a text box annotation object. Two entries 
will be appended to the auxiliary window Measurement. One entry is the area, the other 
is perimeter. 
 
The example below illustrates the process. 
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3.9.3 Polygon 

 
Use the Polygon command to measure the area and perimeter of a polygon. 
 
Click to specify the vertices of the polygon. After the last vertex has been specified, 
double-click right button to start (and to complete) the measurement. During the 
sequence of identifying vertices with mouse clicks, the shape is temporarily closed by a 
graphic line connecting the current point to the start point. 
 
The polygon will be put on the overlay layer of the image. A short text describing the 
measured area and perimeter will appear in a text box annotation object. Two entries 
will be appended to the auxiliary window Measurement. One entry is the area, the other 
is perimeter. 
 

3.9.4 Circle from 3 Points 

 
Use the Circle from 3 Points command to measure the radius of a circle. 
 
Click to specify three points. If these points are not collinear, a circle can be unique 
determined which passes through the three points. After the second point is defined by 
a mouse click, a draft graphic image of the final circle is dynamically presented, until the 
third point is identified.  The circle will appear on the overlay layer of the image. A short 
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text describing the quantity of its radius will appear in a text box annotation object. A 
new entry will be made to the auxiliary window Measurement recording the value of the 
radius. 
 
Repeat the above procedure to measure more circles. 
 
The example below illustrates the process. 
 

 
 

3.9.5 Angle 

 
Use the Angle command to measure angles. 
 
Click to specify three controlling points. The angle made by the line passing through the 
1st and the 2nd point, and the line passing the 2nd and 3rd point, will be measured. 
 
The Angle command, if successfully executed, generates three types of output. The 
angle will be shown as graphics on the overlay layer. A short description of the angle 
will appear in a text box annotation object over the image. The auxiliary window 
Measurement will also have a new entry added. 
 
The following example illustrates the process. 
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3.9.6 Polyline 

 
Use the Polyline command to measure the lengths of connected line segments. 
 
Click to specify endpoints of the connected line segment, or hold down the mouse 
button to incorporate freehand tracing into the polyline object.  Vertices and freehand 
drawing can be interchanged on a single object as desired.  Right button double click to 
signify that all endpoints have been added and the Polyline command has been 
completed.   
 
The total and average length of the line segments will be calculated. The line segments 
will appear on the overlay layer of the active image. A graphic label showing the total 
and average length of the line segments will appear in a text box annotation object. 
Multiple entries will appear in the Measurement auxiliary window, showing the line 
segment lengths between each vertex, and finishing with the total length and average 
lengths of the line segments.  Where a click and drag operation is used to specify a 
polyline, the entire dragged length is treated as a single segment for measurement 
reporting. 
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Note:  During a polyline measurement, the cursor movement can 
be constrained in either the vertical or horizontal direction from 
the last point location.  Holding down the Shift key allows for only 
vertical movement, while holding down the Ctrl key will allow for 
only horizontal movement. 

 
 
 
 
 
 
The example below illustrates the process. 
 

 
 

3.9.7 Light Density 

 
Use the Light Density command to profile the intensity distribution of a row of pixels. 
 
Push down the left button of the mouse to start profiling. A horizontal line will be drawn, 
passing through the position of mouse cursor. The intensity distribution of those pixels 
of the active image on this line will be profiled. This line also stands for the half of the 
dynamic range, i.e. 128. Another line, being drawn below, stands for 0. The curve, 
drawn over the image, stands for the intensities of the pixels.  
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Move the mouse, while keeping the left button of the mouse pressed, to preview other 
rows of pixels. Release the left button of the mouse to finalize the profiling. 
 
Repeat the above procedure for more profiles. 
 
The Light Density command generates graphical output only. 
 
The examples below illustrate the process. 
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3.9.8 Counting 

 
Use the Counting command to simulate a tally machine. 
 
Click to count. A temporary mark appears with each click. Right button double click to 
finish counting. The visited locations will be marked with serial numbers. These graphics 
appear on the overlay layer of the image. 
 
The Counting command also generates an entry in the auxiliary window Measurement. 
 
The example below illustrates the process. 
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3.9.9 Grid Lines 

Use the Grid commands to draw a lattice on the active image. 
 
The Grid Lines draws a rectangular lattice on the overlay layer of the active image. 
 

3.9.10 Grid Circles 

Use the Grid commands to draw a lattice on the active image. 
 
The Grid Circles draws co-centric circles on the overlay layer of the active image. 
 

3.9.11 Grid Options 

 
Use the Grid Options command to specify how grids are to be drawn.  The dialog box 
below is displayed to assist in defining the parameters for the grid overlay.  A grid can 
be generated simply by specifying the distance between lines, and a position relative to 
the image, or the mouse can be used on the image to specify the origin, and dragged to 
dynamically define the grid line spacing. 
 



Lumenera INFINITY ANALYZE 
User’s Manual  Release 6.5.3 

Page 120  Copyright  2006-2016 

 
 

 

Specify whether a rectangular grid or a 
circular grid is being specified 

 

The distance, in microns or pixels, between 
neighbouring parallel lines of the 
rectangular grid or between rings in the 
circular grid. 

 

Choose between using pixels or the 
specified working units based on the 
current calibration 

 
Choose this option to drag the origin and 
inter-line distance for the grid parameters 

 

A specific (X,Y) coordinate location in the 
image can be used for the grid reference 
point. 

 

Choose the desired reference location for 
the origin of the grid relative to a corner of 
the image, or using the center of the image 

 

Select to close the dialog and keep the 
settings. 
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Select to close the dialog and discard any 
change to grid options. 

 

3.9.12 Cell Count 

 
ANALYZE provides the ability to perform automated cell counting based on a defined 
threshold in the pixel intensity of identified locations in the captured image.  Refer to the 
section on Cell Count Options for details on controlling the response from the Cell 
Counting operation. 
 
Once initiated from the menu, the cell counting mouse pointer is displayed as an eye-
dropper icon.  Click the left mouse button on a nucleus, or region of interest.  The 
identified pixel is highlighted in the color identified for Nucleus in the Cell Count Options.  
Simultaneously, all other pixels within the image that fall within the specified tolerances 
for the Red, Green, and Blue intensity values are also highlighted. 
 
Either complete the operation at this point, or continue to identify additional pixels using 
further choices with the left mouse button, to provide a more complete definition of the 
cell nucleus, or region of interest.   
 

 
 
If the Ctrl key is down when the left mouse button is clicked, the segmentation will be 
localized. That is, only pixels immediately adjacent to the click location, and those 
immediately adjacent to the pixels just identified as nucleus pixels, will be considered.  
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Click the right mouse button to delete a nucleus.  
 
If the Ctrl key is down when the right mouse button is clicked, the nucleus will be 
separated into two (or occasionally more) nucleuses.  
 
Double click the right mouse button in an area of the image that has not been 
highlighted, to complete the segmentation and complete the counting process.  
During the process, spaces within the nucleus with radius less than the closing 
parameter specified (in pixels) will be filled, and boundaries with jumps less than the 
closing parameter specified (in pixels) will be trimmed. When the counting process 
finishes, the nucleus will no longer be highlighted with the overlay color, but the nucleus 
boundary and index number will be shown. All areas matching the specified tolerance 
criteria will be identified by a boundary and counted. The total number of cells will be 
added to the Measurement Result, along with the total area occupied by the identified 
regions.  (Note: The boundary graphic is smoothed for improved appearance)  
 

 
 
The above process may be repeated on the same image, for improved control over the 
results. For example, during the first attempt the left mouse button is used for 
segmentation.  While on a second call to the Cell Counting function on the same image 
could involve using the right mouse button to remove outlying pixels. When the same 
image is counted again, previous result will be replaced by the new one.  
 
Image segmentation results from the cell count operation are also reported in the 
Photometry auxiliary window.  The pixel intensity values are presented along with pixel 
counts for each of the Red, Green, and Blue channels based on their actual values, 
along with summary statistics.  Enable the Photometry auxiliary window and select the 
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Segment tab to display the results of the cell count operation.  This data can be copied 
into a spreadsheet using a drag & drop operation. 
 

 

3.9.13 Cell Count Options 

Choose Measure->Cell Count and a dialog appears. The dialog specifies the colors to 
paint segmented nucleus area, boundary and index number.  The tolerance values for 
Red, Green, and Blue indicate the range within which a pixel must match those 
identified during the segmentation process.  A lower value on any color will tighten the 
tolerance and improve the control over which similar pixels are identified.  A larger 
tolerance value will relax the selection criteria resulting in more pixels being identified 
with each mouse click during the segmentation process. 
 
The Font size parameter provides control over the text label font size for the 
segmentation results.  The Closing parameter defines the tolerance for holes or gaps 
within the nucleus or region of interest that will be filled during cell counting.  It also 
defines the space between adjacent regions that will be closed if they are less than 
specified by this distance in pixels.  
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3.9.14 Unsort Measurements 

The measurement window provides the operator with the ability to sort the list of 
measurements with a mouse click in any of the table columns.  The rows of 
measurement results are sorted based on the value in the chosen column.  The Unsort 
Measurements option will display the results in the original ordered list. 
 

3.9.15 Clear Measurements 

 
Use the Clear Measurements command to clear overlay layer and measurement result 
of the active image. 
 

3.9.16 Delete Selected Measurement 

Individual measurement objects can be selected and deleted.  Move the mouse over 
measurements placed on a live or captured image.  When the cursor comes within 
identification range of a measurement the cursor graphic is altered to include a small 
rectangular (ruler) shape in the lower right corner.  Selecting using a left mouse click 
when the cursor is displayed in this manner, will result in the graphic becoming 
selected.  This is indicated by a color change on the selected measurement.  The menu 
option Delete Selected Measurement is only available when a measurement object is 
currently selected. 
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The measurement graphic and the associated measurement text are removed from the 
captured image or the live preview display, and the measurement record(s) is/are 
removed from the Measurement auxiliary window.   

3.9.17 -> Excel 

This feature allows for the direct export of the measurement records belonging to the 
active image, into an Excel spreadsheet.  The drag and drop option from the 
Measurement auxiliary window remains available, and may be preferred to extract 
specific measurement records into a pre-populated spreadsheet.  However, this function 
simply launches MS Excel, and transfers the measurements directly into a new Excel 
spreadsheet. 
 

3.9.18 Abort 

 
Use the Abort command to terminate the present measuring operation. 
 
Equivalent command 
 
Right button double click on the active image being measured. 
 

3.9.19 Calibrate 

 
The Calibrate function is used to allow ANALYZE to create a reference for taking 
accurate measurements from captured images.  The Calibration step is performed for 
each objective or magnification used on the microscope.  It takes into account the 
camera sensor‟s pixel size, the optical coupler, and the other objectives within the 
microscope.  The calibration performed for each magnification can be stored as presets 
for future use.  (Refer to the section on Camera Control and Presets for details on 
saving calibrations). 
 
The system micrometer consists of the sampling intervals in both the horizontal and 
vertical directions, and the magnification intended for printing this image. INFINITY 
ANALYZE derives the sampling interval from the length of a straight line segment on the 
image.  A captured image showing a stage micrometer, a calibration slide, a ruler, or 
any object of known dimensions, may be used to perform a calibration. 
 
Capture an image and invoke the Calibration function from the Measure menu.  Click 
the left mouse button on the first end-point in the image to begin a measurement.  The 
mouse button may be released, as the rubber-band reference line is drawn on the 
screen, the end-point will follow the mouse position.  Once the mouse is over the 
desired end-point, perform a second left mouse click to complete the operation.   
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Note:  It is also possible to perform the calibration directly on the Live 
Preview window, without the requirement to capture an image.  When 
performing a calibration using a captured image, ensure that the 
„Capture full field of view‟ option is enabled and that Subsampling is 
set to 1, in the Capture Options pane. 
 

While the calibration function is active, between the specification of the first and last 
end-points, the scroll bars on the bottom and right sides of the image can be used to 
perform a pan operation.  This feature allows for accurate mouse pointer clicks on both 
the end-points of the reference object during the calibration.   
 

 
 
 
 
 
As soon as the second end-point position is indicated with the left mouse click, the 
Calibration dialog appears.  The fields on the dialog allow for the specification of the 
length, magnification, and working units.   The final steps to complete the calibration are 
outlined below. 
 
 

 
 
 
 

a. Begin by specifying the length of the line that was just dragged 
between the two end-points.  Be as accurate as possible when 
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Note:  A dropdown list of popular units is available on the bottom of 
the Micrometer Calibration dialog, to facilitate the identification of 
units and the respective relationship to Microns (um). 
 

entering this value.  Do not specify any units in this field, simply 
enter the numeric length.  Decimal places are not accepted for 
lengths identified in microns. 

b. Enter a numeric value to represent the magnification.  This value 
does not impact the calibration in any way, but does serve as a 
reminder label in the Status Bar, whenever this calibration is active.  
(Example:  If using a 20X objective, enter 20 in this field) 

c. As ANALYZE provides the ability to calibrate the system to any 
desired units, the final three fields on this dialog are used to define 
the desired measurement units for ANALYZE to use.  The Linear 
Unit and Square Unit abbreviation fields are available to specify 
how measurement units are to be presented. 

d. Finally, the relationship between microns and your preferred units 
of measure are specified in the field to the right of Linear Unit.  If 
working in microns, then this field is left as 1.  If working in any units 
other than microns, then the value entered into this field is the 
number of microns in one unit of the desired measurements.  For 
example: enter 25400 in this field if working in inches, or 25,400 if 
working in thousands of an inch.   
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Enter the length of the line, in 
the units you plan to use. 

 
Enter the nominal 
magnification. The 
magnification is used in 
printing only where the image 
appears magnified on paper. 
Measurements are not 
impacted by the magnifying 
factor. 

 
The linear unit is specified as 
a preferred abbreviation along 
with the numeric designation 
for the number of microns in 
one of these measurement 
units.  (eg. mm = 1000um) 

 
Specify the preferred 
measurement abbreviation for 
area units. 

 

Optional dropdown list 
selection of common unit 
types 

 
Push to close the dialog and 
commit the new settings of 
system micrometer. 

 
Push to close the dialog and 
discard any change to system 
micrometer. 

 
 
 
 
 

3.9.20 Measure Options 

 
The Measure Options dialog is used to specify how measurement annotations appear in 
the image. The first option on the dialog defines whether annotation graphics are 
generated or not.  The number of Decimal Places is used to control the level of detail 
included with the measurement labels that appear.  A dropdown dialog box allows for 
the selection of using either a comma (,) or a period (.) as the decimal separator. 
 
 

IMPORTANT Note: Calibration should only be performed when 
Subsampling is not enabled (ie.: it should be set to 1) 
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The remaining fields on the dialog allow for the specification of the Prefix characters that 
appear ahead of each measurement label that is generated.  The operator can identify 
whether all, some, or none of the measurement types will produce a measurement in 
the captured image, and if a measurement is displayed, the actual prefix to use. 
 

 
 

Note: Use the Annotate -> Properties function to make modifications 
to any of the text font, style, color settings, or to the graphic properties 
of objects.  For additional details on the Font and Graphic controls, 
refer to the descriptions provided under the section on Annotations 
(Section 3.10.15).  
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Use this setting to enable or disable the 
generation of measurement labels 
adjacent to each new measurement. 

 
Specify the desired precision for the 
measurement results 

 
Select the desired character from the 
dropdown list, to represent the decimal 

 
Specify the desired prefix text to appear 
for each of the available measurement 
types in the list. 

 

For each measurement type, select 
whether the text is to be displayed or 
suppressed using the checkbox 

 

The behaviour controlled by this specific 
option is different than for those listed 
above it.  Enabling this checkbox means 
that all polyline measurements will have 
an output length stored in the 
Measurement Results, for each individual 
line segment length. 

 

Click the OK button to implement these 
settings 

 

Choose cancel to close the dialog while 
discarding the most recently made 
alterations. 

 

3.10 The Annotate Menu 

 
Annotation objects can be added to any captured image using the functions available on 
the Annotate menu.  Adding annotation objects relies on mouse operations of click or 
drag to position and size objects.  Select an annotation object and choose Annotate -> 
Properties, or use a left-mouse double-click on an annotation object, to display the 
dialog box that controls the appearance of various annotation text and graphics. 
 
One or more annotation objects can be selected. Click to select an object in the 
annotating mode. Shift + Click to select an additional object. To select all the annotation 
objects, press Ctrl + A. To deselect all the annotation objects, double-click anywhere 
that is not occupied by an annotation object. 
 
Selected objects can be moved together. To move selected objects, drag any one of 
them. Selected objects can also be cloned. To clone selected objects, click any one of 
them while pressing down the Ctrl key. 
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When a selected object is the only selected object, it may be resized. To resize an 
annotation object, drag its resizing handles. An annotation object can have as many as 
nine resizing handles located on the bounding rectangle of the annotation object. 
Resizing handles usually reside at the four corners or the center of line segments. To 
detect a resizing handle, hover the mouse over the bounding rectangle and wait for the 
change of cursor. If a resizing cursor appears, it means the mouse is over a resizing 
handle. Note the bounding rectangle will not appear until the object is selected. 
 
Each annotation object has a set of properties associated with it. The properties may be 
edited through popup dialogs. To change the properties of an annotation object, double-
click that object. 
 
The mouse cursor changes to a cross with a dotted box shape to the lower right corner, 
when the Annotate -> Select is active.  When the cursor is in the vicinity of an 
annotation object, the dotted box changes to a shaded circle.  It is also possible to 
choose one or more annotation text objects with a drag of the mouse to encompass 
multiple objects when in Select mode.  The Delete key on the keyboard can be used to 
remove selected graphic objects from the image. 
 
 

 
 
 

3.10.1 Project 

The Project feature within the Annotate menu allows for a template of overlay objects to 
be defined for inclusion in the live display or captured images.  This concept is similar to 
having a bitmap overlay generated in real-time for image annotation.  Use the Project 
dialog box to enable or disable specific Project Tags, and to enter text into the user 
defined fields as desired. 
 
Fields are provided to define custom text strings that are added to the project overlay.  
Other fields can be enabled so that the application will pull information from the 
computer such as timestamp, date, or filename information that will be included on an 
image at the time of acquisition.  The last option in the Project allows for a bitmap file to 
be specified for inclusion as an annotation object.  The bitmap should be kept to a small 
size, where possible to reduce the impact on system performance and output image file 
size.  The bitmap image must an RGB24 bitmap with the background  
 
The process for setting up Project Tags requires both the identification of the item on 
the Project dialog, and the specification of the item location using the Project Tag menu. 

Note:  The Annotate  Select function will remain active until the 
operation is cancelled using the Edit  Abort menu item, or switching 
to another action. 
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To remove an unwanted Bitmap Overlay file from the Project dialog, click on the Open 
Bitmap File button, and then select the Cancel button without specifying a filename.  
Bitmap objects cannot display white backgrounds as transparent at this time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the Annotate -> Properties dialog to access the text and graphic display 
characteristics for the individual tags.  The properties defined for the font, color, size, 
etc., apply to any tags placed after the property settings are made.  However, the 
properties for an individual tag can be changed also. 
 

3.10.2 Project Tags 

 
The Project Tags flyout menu is used to assign a spatial position to each specific project 
tag.  The position for any Project Tag need only be made if that tag is to be used.  
Unused tags do not need to be positioned.  Tags can be placed on captured images or 
on the live preview.  It is easiest to position a Project Tag using a mouse drag operation.  
Click the left mouse button to start the location point of the item, and release the mouse 
after dragging is complete.  If the Project tag has been defined and made active on the 
Project dialog, then it will be dynamically displayed during the drag operation. 
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If Project Tags are placed using a captured image, the Annotate menu function called 
Duplicate on Live Image can be used to create an overlay shown in the live preview.  
The Project Tags will then be added to each captured image.  Changing the definition of 
a Project Tag on the Projects dialog will result in the item being updated in the overlay 
shown on the Live Preview.   

 
The FILENAME project tag will populate the saved image filename (and / or file path) 
when the Capture Options parameter is setup with Save to File.  If an image is captured 
to the Field Group, and then saved to File, the placeholder “<FILENAME>” will be 
burned into the image, rather than the actual storage location and file name.  The use of 
this Project Tag is intended when saving images directly to disk on acquisition.  
 
To remove Project Tags from the Live Preview, simply open the Project dialog and 
Disable All tags. 

3.10.3 Enable Hand Tool 

 
Use the Enable Hand Tool command to toggle annotating mode. 
 
In the annotating mode of INFINITY ANALYZE, all mouse actions over the active image, 
except those for annotation, are disabled.  
 

3.10.4 Line 

 
Use the Line command to add line objects. 
 
Each line object is defined by two endpoints. Press left mouse button to specify one of 
the endpoints. Move the mouse to the other endpoint, while keeping the left mouse 
button pressed, to draw the line. Release the left mouse button to complete the line 
drawing. 
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Repeat the procedure outlined above, to create more lines. 
 
A line object has two resizing handles, located at the two endpoints. 
 

 
 

 
Show the color to draw the line. Click to pick 
up a new color from the popup palette as 
illustrated below. 

 
 
Push Automatic to specify the light gray 
color. Push More Colors to bring up the 
Windows Color Picker Dialog for more and 
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customized colors. 

 
Show the width of line. A new value may be 
entered directly. Or use the spin buttons to 
adjust the setting. 

 
Show the style of the line. Click to pick up a 
new style from the popup style selector as 
illustrated below. 

 

 
If checked, the endpoints of the line will be 
drawn as solid balls. 

 
 

3.10.5 Rectangle 

 
Use the Rectangle command to add rectangle objects. 
 
Each rectangle is specified by two diagonal vertices. Press down left mouse button to 
specify one vertex. Move the mouse to the other vertex while keeping left mouse button 
pressed to draw the rectangle. Release left mouse button to complete the creation of 
this rectangle. 
 
Repeat the procedure above to add more rectangle objects. 
 
A rectangle object has eight resizing handles as illustrated below. Drag the handles at 
the four corners to adjust width and height of the rectangle simultaneously. Drag the 
other handles to adjust width or height but not both. Drag anywhere else within the 
rectangle to move the rectangle object. 
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Double-click a rectangle to edit its properties. As illustrated below, the properties of a 
rectangle object consist of those properties of those four lines that make up the 
rectangle and the properties that specify how the interior of the rectangle is to be 
painted. 
 

 
 
For line properties, please refer to the Line command. The painting of the interior of a 
rectangle is defined by the Fill sector of the above dialog. 
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Show the present color to fill the interior 
of the rectangle. Click to pick up a new 
color as shown below. 

 
 
Click Automatic to choose gray. Click 
More Colors to bring up the standard 
Windows Color Picker Dialog where a 
new color may be defined. 

 
If checked, the Color property will be 
ignored and the interior of the rectangle 
will not be painted to allow the 
otherwise obscured objects or pixels to 
be visible. 

 
 

3.10.6 Round Rectangle 

 
Use the Round Rectangle command to add round rectangle objects. 
 
A round rectangle is similar to a rectangle except that its corners are made up of arcs. 
The creation, moving, resizing and editing of a round rectangle is similar to those of a 
rectangle except for the following. 
 
A round rectangle has nine resizing handles. The handle within the round rectangle, as 
shown below, is used to adjust the roundness of the corners. 
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A round rectangle has limited line properties. The line styles other than the solid cannot 
be specified for a round rectangle. 
 

3.10.7 Ellipse 

 
Use the Ellipse command to add ellipse objects. 
 
An ellipse is fully specified by its minimum bounding rectangle. The creation of an 
ellipse object is identical to that of its minimum bounding rectangle, as illustrated below, 
although the rectangle is not visible when the ellipse is not selected.  
 

 
 
An ellipse is moved, resized in the same way as a rectangle object. The properties of an 
ellipse are identical to those of a round rectangle, i.e. only solid line style is applicable. 
 

3.10.8 Polygon 

 
Use the Polygon command to add polygon objects. 
 
There are two ways to create a polygon object, by clicks and by freehand drawing. 
 
By Clicks 
 
A polygon is specified by its vertices. Click to add a new vertex. Double-click to add the 
last vertex. 
 
By Freehand Drawing 
 



  Lumenera INFINITY ANALYZE 
Release 6.5.3   User’s Manual 

Copyright  2006-2016  Page 139 

Press down the left mouse button to start drawing. Move the mouse while keeping left 
button pressed to draw a polygon. Double-click to finish drawing. 
 
If a polygon has been created by clicks, each vertex is a resizing handle. If a polygon 
has been created by freehand drawing, each point on the drawing is a resizing handle. 
See below for an illustration. The polygon on the left is created by clicks; the one on the 
right is created by freehand drawing. 
 

 
 
A polygon has an identical set of properties to that of an ellipse. 
 

3.10.9 Arrow 

 
Use the Arrow command to add arrow objects. 
 
An arrow is made up of an arrow head, an arrow trailer, and a line connecting the arrow 
head and trailer. The arrow head and arrow trailer are shapes consisting of enclosing 
lines and interiors. The lines enclosing arrow head and arrow trailer, and the line 
connecting the arrow head and arrow trailer, have full line properties associated with 
them. The interiors of arrow head and arrow trailer have full fill properties associated 
with them. 
 
An arrow is created, moved and resized in the same way as a line. The properties of an 
arrow include, besides line and fill properties, the shape and size of arrow head and 
arrow trailer as shown below. 
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Click to pick up a new style of the arrow head. 
 

 
 
The style of the arrow trailer is set in a similar way. The shapes of arrow trailer are 
mirrors of those of arrow head. 
 
Use the spin button to adjust the size of arrow head or arrow trailer. The size is defined 
as diameter of the bounding circle of the shape measured in pixels. 
 
 
 



  Lumenera INFINITY ANALYZE 
Release 6.5.3   User’s Manual 

Copyright  2006-2016  Page 141 

3.10.10 Text 

Use the Text command to add text box objects. 
 
Click to add a text box object. Unlike other annotation commands the property dialog 
appear immediately upon the creation of a text box object, as illustrated below. 
 

 
 

 
Push to open the standard Windows Font Dialog 
where a font, including its style, size, and effects, 
may be specified for the text in the annotation 
object. 

 

Enter the text for the annotation object. 

 
Show how the bounding rectangle of the text 
appears. Click the drop list to specify whether 
the bounding rectangle is to be displayed 
straight as a rectangle, or a round rectangle, or 
an ellipse, or not to be displayed at all.  

 
Show how the text is positioned in the bounding 
rectangle. Click the drop list to specify whether 
the text is to be left justified, right justified, or to 
be placed in the center. 
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If the bounding rectangle is to be shown, the line and fill properties apply to the 
bounding rectangle. If the bounding rectangle is to be shown as rectangle, full line 
properties apply. If the bounding rectangle is to be shown as round rectangle or ellipse, 
line style is forced to be solid and the other line style settings will be ignored.  
 

3.10.11 Micrometer  

 
 

Use the Micrometer command to add and customize the graphical representation of the 
micrometer.  When invoked, the micrometer function requires that the operator use a 
left mouse click on a captured image.  As soon as the mouse click is performed, the 
Micrometer dialog is displayed. 
 

 
 
Specify the desired Length for the micrometer bar in the field. Use the Line & Font 
button to access a subsequent dialog with options to configure the appearance of the 
micrometer with respect to font style, size, and color.   
 
If a filled rectangle is desired around the length text, and graphic object, a border must 
be enabled from the Line & Font dialog. 
 
Click on OK to have the micrometer bar appear at the mouse click location used to 
initiate the process.  An alternative is to click on the Use Last Position button which 
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overrides the mouse click coordinate, and uses the location that was referenced the last 
time a micrometer was placed in an image.  This feature allows for the micrometer bar 
to be placed in a consistent location from image to image.  The “Use last position” 
checkbox should also be enabled, to alter the width and height settings of the currently 
selected micrometer. 
 
 

 
The length of the scale bar, in microns, to be drawn on the 
overlay layer of the active image. 

 Check this option to automatically add a label showing the 
specified length.  With this option un-checked, no label is 
generated 

 
Ignore the most recent mouse click location and place the 
micrometer bar at the previously used location, when 
checked.  Also use this option when changing the current 
width and height dimensions to have the currently selected 
micrometer graphic updated.   

 
Access the color and settings for the text label font and 
graphic options 

 

Numeric fields for Micrometer placement.  The coordinate 
represents the (X,Y) pixel position within the image, for the 
center of the micrometer bar, with respect to the upper left 
corner of the image (0,0) 

 

Numeric value representing the width (in pixels) of the 
bounding rectangle for the graphic surrounding the 
micrometer bar, including the label text.  Adjust this value 
to obtain the desired text position if left or right text 
justification is used. 

 

Numeric value representing the height (in pixels) of the 
bounding rectangle for the graphic surrounding the 
micrometer bar.  Adjust this value to increase or decrease 
the distance that the text is from the micrometer bar.  A 
negative value is used to position the text below the line, 
and a positive value puts the text above the line. 

 
Push to dismiss the dialog and put the new options for 
burning micrometer in effect. 

 
Push to dismiss the dialog and discard any change to 
options for burning micrometer. 

  
Note that the length parameter for the micrometer is now stored with each preset.  Each 
captured image has a known calibration scale, if ANALYZE has been calibrated for 
specific objectives, and the calibrations are stored as Presets.  Having the micrometer 
length recalled for each individual preset means that the last used length will be 
automatically presented in the Micrometer dialog for the calibration that was active 
when the image was captured. 
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3.10.12 Select 

 
Use the Select command to select one or more annotation objects. 
 
Click to select an annotation object. Shift + Click to select additional objects. It is also 
possible in this mode to draw a rectangle to select all objects covered by the rectangle. 
 
The mouse pointer appearance alters when the cursor is positioned above an 
annotation object or a selected annotation object, such that the appearance indicates 
the type of operation enabled.  
 

 

When the pointer appears as a cross with a segmented rectangle, a 
measurement graphic can be selected with a left-mouse click.  A 
selected measurement graphic can only be deleted (not modified). 

 

When the pointer appears as a cross with a closed circle, an 
annotation object can be selected by a left-mouse click.   

 

The selected annotation object can be re-positioned by a mouse click 
and drag operation.  This pointer also indicates that a mouse double-
left-mouse click will open the graphic properties for the annotation 
object. 

 

The annotation object is selected and 8 “handles” are highlighted, 
when this pointer shape appears.  It indicates that a single left-mouse 
click and drag operation can be used to resize the object.  When the 
drag operation is complete, the object is automatically de-selected.  
Use any corner handle to allow re-sizing in both height and width at 
the same time. 

 

Mouse cursor is away from the selected annotation object, and no 
operation will be performed on the object when the left mouse button 
is clicked. 

 
Click anywhere within the active image window that is not occupied by any annotation 
object to deselect all objects. 
 

3.10.13 Select All 

 
Use the Select All command to select all annotation objects. 
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3.10.14 Delete 

 
Use the Delete command to delete selected annotation objects. 
 

3.10.15 Properties 

 
Use the Properties command to edit the properties of a selected object.  When this 
option is used the entire suite of Property dialogs is opened.  The active tab typically 
belongs to the selected annotation object type, making a modification to those 
properties relevant.  However, it is also possible to access the object properties for 
other object types, by selecting the relevant tab.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Properties tabs are available for the text attributes and the graphic attributes of the 
different annotation object types. 
 

3.10.16 Move to Uppermost 

 
Use the Move to Uppermost command to make the selected object the topmost layer. 
 

3.10.17 Move to Lowermost 

 
Use the Move to Lowermost command to make the selected object the bottommost 
layer. 
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3.10.18 Move Up 

 
Use the Move Up command to move the selected object one layer above. 
 

3.10.19 Move Down 

 
Use the Move Down command to move the selected object one layer down. 
 

3.10.20 Duplicate on Live Image 

 
Use the Duplicate on Live Image option to copy Project Tags and other annotation 
objects as an overlay in the Live Preview.  When the annotation objects are present in 
the live preview, they will be duplicated into each captured image as annotation objects.  
This means that they can be individually selected such that their properties can be 
modified, or they can be moved or deleted. 
 

3.11 The Window Menu 

 

3.11.1 Cascade 

 
Use the Cascade command to make all image windows the same size and stacked from 
top left to bottom right of the main window. 
 

3.11.2 Tile Horizontally 

 
Use the Tile Horizontally command to make all image windows aligned edge to edge 
horizontally and the same size if possible. 

3.11.3 Tile Vertically 

 
Use the Tile Vertically command to make all image windows aligned edge to edge 
vertically and the same size if possible. 
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3.11.4 Arrange Icons 

 
Use the Arrange Icons command to align the icons of image windows at the bottom of 
the main window. 
 

3.12 The Help Menu 

 

3.12.1 Settings 

Application settings are controlled from the Help -> Settings dialog.  Note that some 
settings are only effective after the INFINITY ANALYZE application has been re-started. 
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3.12.1.1 Operation 

Use the Operation tab panel on the Settings dialog command to tune the 
performance of INFINITY ANALYZE. 

 
 

 

 
The number of thumbnails in Field Group. 

 
The size of the memory, in MB, that has been 
allocated to Field Group. 

 
The maximum length of processing history for each 
image. 

 
The Gamma of computer screen, in hundredth. 

 
This parameter will limit the upper range of the 
continuous Auto Exposure time.  As the microscope 
objective turret is rotated the camera is briefly 
deprived of light.  Use this setting to limit how long 
an exposure time is reasonable for the AE to use.  
The actual parameter depends on the lighting and 
objectives. 

 This option is only available when an INFINITY3-
3UR camera is connected. If you require a frame 
rate performance increase in the live preview, enable 
this option.  Image quality is reduced slightly in the 
live preview only (no impact on captured images), to 
achieve faster frame rate processing at short 
exposure times. 

 
Enable this check box to ensure that the Live 
Preview window remains visible as images are 
captured into the working area. 

 This option is enabled be default.  Deselect this 
option to allow the live preview to remain unfrozen 
during measurement operations. 

 
The selected video encoder will be used to process 
the video clips acquired using the option in the Time 
Lapse.  ANALYZE cannot determine the status or 
effectiveness of any encoder installed on your PC.  
Only choose a different video encoder if you are 
confident that it is fully supported by the codecs on 
your computer. 

 
Push to dismiss the dialog and to apply the settings 
when INFINITY ANALYZE runs again. 

 
Push to dismiss the dialog and not to change any 
setting. 
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3.12.1.2 Interface 

Use the Interface panel on the Settings dialog command to quickly alter the 
appearance of the ANALYZE toolbars and Auxiliary Windows.  Changes made 
to the user interface from this panel take effect immediately, making it an easy 
task to determine which toolbars or auxiliary windows are preferred. 
 

  
 

 

Identify the Toolbars to be visible in the user 
interface 

 

Identify which Auxiliary Windows are enabled 

 
Quickly toggle between Simple Mode and 
Enable All to have either a minimum set of 
controls or the full suite 
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3.12.1.3 Multispectral Capture Wizard 

 
See section 3.2.2.3 for details on the specific settings that relate to the MultiSpectral 
Capture Wizard settings. 
 

3.12.2 Settings for Database  

 
Use the Settings for Database command to choose an alternate location and file for the 
INFINITY ANALYZE database record and the storage location of images.  The 
performance of INFINITY ANALYZE may be reduced if the database and image storage 
are configured to use a remote or network folder location. 
 

 
 

 Select this option to use the 
default database stored in the 
same location where 
INFINITY ANALYZE is 
installed 

 
Select this option to specify an 
alternate location for the 
database file and image 
storage 

 
Identify the location and 
filename of the remote 
database.  It can be on a 
network drive, or in another 
local folder, as desired.   
 
Important:  Copy the default 
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database file from the 
INFINITY ANALYZE folder 
location to this new location 
prior to invoking this feature  

 
Browse to select the folder 
location 

 
Identify the folder location 
where database images are to 
be stored 

 
Browse to select the folder 
location 

 
Select to accept the settings 
and close the dialog 

 
Select to cancel the changes 

 

3.12.3 Manual 

 
Use the Manual command to open this User‟s Guide from within INFINITY ANALYZE. 
 

3.12.4 Online Help 

 
Use the Online Help to connect to the Lumenera website, where video tutorials are 
located.   
 
The URL for the video tutorials page is: 
 
http://www.lumenera.com/support/microscopy/training.php 
 

3.12.5 About Analyze  

 
Use the About INFINITY ANALYZE command to read copyright notice and version 
information. 
 

http://www.lumenera.com/support/microscopy/training.php
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 3 4

Imaging Control 

 
This section details the commands for controlling the INFINITY Camera.  It includes the 
ability to store camera presets, which include calibrations for microscope objectives, 
and camera settings that allow the camera to be quickly restored to a predefined 
setting.  

4.1 Imaging Control 

 
The camera presently connected to INFINITY ANALYZE, and the whole image 
acquisition process, can be fully controlled from within the Imaging Control Pane of the 
Control Panel. Image acquisition will be based on the current camera settings and 
capture options which are configured by the seven sub-panes of the Imaging Control 
Pane described in detail below.  
 
Camera settings refer to those parameters that are necessary to put the camera into a 
specific state. Capture options refer to what INFINITY ANALYZE will do to the frames 
grabbed from video stream of the camera, including calibration for purpose of 
measurement and printing. In fact, system micrometer has to be properly scaled before 
applying to the newly formed image, according to the subsampling factor specified in 
capture options. The contents of camera settings, capture options and calibration 
information are listed below. 
 

Camera 
Settings 

Exposure The length of time that each pixel is exposed prior to an 
image being transferred from the camera 

Gain The amplification applied to the signal before it is 
converted to a digital output 

Gamma A look-up table enhancement designed to reveal details 
in the dark regions of an image 

White Balance The camera‟s Red, Green, and Blue channel gains are 
adjusted to produce a balanced result for the current 
lamp source (color temperature). 

Flip / Mirror Re-orient the camera‟s output left/right or top/bottom.  
This is used to match the camera output to the view in 
the oculars, while the USB cable is oriented to the back 
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of the microscope 

Light Source  The light source setting applies a custom color correction 
matrix designed to compensate for the color bias in the 
way a sensor detects the Red, Green, and Blue 
wavelengths present in the lamp source. 

Camera 
Control 
Extended 

Saturation An adjustment to the strength or vivid appearance of the 
camera output 

Hue A tint adjustment used for fine tuning the color output 
(typically left at the default setting) 

Brightness An adjustment to the image intensity (typically left at the 
default setting) 

Contrast Adjusts the ratio of dark and light values (typically left at 
the default setting) 

Capture 
Options 

Frame 
Averaging 

Specifies whether the application is to acquire multiple 
images and average the result on Capture.  This 
operation may be used to reduce the appearance of 
temporal noise in the camera output under certain 
conditions.  Typically left at 1. 

Subsampling Specifies that the camera‟s spatial output be reduced by 
the specified factor.  For example, using a value of 2 will 
result in every second pixel and every second row being 
discarded, and the resulting image will be ¼ the size of 
the original. 

Destination Where to store the acquired images. It can be Field 
Group, disk files, or both. A new image window may also 
be created to hold a newly acquired image. 

File Name The path of the file that may be used to store a newly 
acquired image. 

Capture Full 
Field of View 

INFINITY ANALYZE may be directed to exploit the full 
pixel array of the camera for the image acquisition, or 
just to grab a frame from current video stream, which 
may be sub-sampled or only part of the field of view. 

Preview 
Captured 
Image 

A new image window may be created to hold a copy of 
the just acquired image. 

Verify File 
Name on 
Capture 

Show a File Save As dialog box for each acquired image 
that is to be stored to a file. This option may be used to 
prevent overwriting an existing file or to convert the 
image to another format. 

Auto Increment 
File Name 

INFINITY ANALYZE may be directed to name the files 
automatically to store the acquired images. It does so by 
appending a serial number to the initially specified file 
name.  
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4.1.1 Capture Control 

 

 
 
Presets 
 
A preset consists of a complete set of parameters for controlling the camera, a subset of 
capture options and image calibration information as detailed below. 
 

Camera Settings Exposure 

Gain 

Gamma 

Saturation 

Hue 

Brightness 

Contrast 

White Balance 

Rotation 

Flip 

Light Source Temperature 

Capture Options Frame Averaging 

Subsampling 

Calibration Information 
(Micrometer) 

Sampling Intervals 

Magnification 

 
INFINITY ANALYZE maintains a list of uniquely named presets entered by the operator. 
A present name is a single line of text, which is entered when a preset is created and 
added to the preset list, as shown below. 
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Show the name of the preset that is currently 
applied. Click to apply another preset. 
A special preset, named “Default”, will be 
created by INFINITY ANALYZE whenever a 
new camera is attached. It is always the first in 
the preset list and contains factory settings.   

 
Push to remove the current preset from the 
preset list. Note that the present camera 
settings, capture options and system 
micrometer will not be affected. Just that the 
preset is deleted from the list. 

 
Push to create a new preset and add it to the 
preset list. The name of the preset is specified 
in the dialog above. The content of the preset 
is derived from the current camera settings, 
capture options and system micrometer. 

 
Use the Update button to apply a change in 
camera settings to an existing Preset 

 
Most Important Camera Settings 
 
Color reproduction and overall brightness dictate image quality. The color reproduction 
of a camera is controlled by gains applied to color channels of the camera. It is most 
efficient to let INFINITY ANALYZE determine the necessary gains from live images, a 
process known as white balance. White balance may be based on either the whole live 
image that is currently being displayed or a small area therein. INFINITY ANALYZE 
uses the term White Balance for the operation based on the whole image and Area-
Based White Balance (Area WB) for the operation based on a small area within the live 
image. Much like white balance, an optimal exposure time may also be determined by 
INFINITY ANALYZE. Auto Exposure refers to the operation that INFINITY ANALYZE 
determines and sets an optimal exposure time based on the visible portion of the live 
images being displayed. 
 
   



Lumenera INFINITY ANALYZE 
User’s Manual  Release 6.5.3 

Page 156  Copyright  2006-2016 

 
Push to perform white balance based on the visible portion of the live 
image. 

 
Push to perform white balance based on a small rectangle within the 
visible portion of the live image. The operation is completed by a click on 
the live image, which specified the center of the rectangle on which the 
white balance will be based. The width and height of the rectangle is the 
smallest region of interest that is supported by the camera. 

 
 
 
 
Capture 
 

 

Push to acquire an image based on the current camera settings and 
capture options. The acquired image will be automatically calibrated 
according to system micrometer and present decimation factor. 

 
  



  Lumenera INFINITY ANALYZE 
Release 6.5.3   User’s Manual 

Copyright  2006-2016  Page 157 

4.1.2 Camera Control 

 
The exposure, global gain and Gamma of the camera may be set from this sub-pane. 
 

 
 

 
Stops the live preview and closes the Preview window 

 

Opens a new live preview window and resumes updates 

 

Use the slider to adjust the exposure time of the camera. The 
exposure is in milliseconds and is adjusted logarithmically. 

 The minimal exposure time allowable for the camera. 
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Show the current exposure time of the camera. A new value 
may also be entered directly using the keyboard. The 
exposure is in milliseconds. 

 The maximal exposure time allowable for the camera. 

 
Selecting this option will allow the camera to use exposure 
times in the live video preview between 500ms and 2000ms, 
by operating the camera in a Snapshot mode to acquire and 
display frames.  This function should only be required under 
extremely light challenged applications, such as low-light 
fluorescence. 

 
Select the Continuous Auto Exposure feature to have the 
camera exposure controlled automatically in response to the 
amount of illumination reaching the camera.  As the 
magnification or objectives are changed, the camera will 
adjust the exposure time automatically to attempt to achieve 
the desired target brightness indicated by the Average 
Intensity value.  Note: Refer to the Help -> Settings dialog to 
impose upper limits on the auto exposure range, for improved 
performance. 

 

The average pixel intensity across the image is calculated so 
that the camera exposure time can be increased or reduced 
to achieve the target brightness.  The slider represents the 
pixel intensity average on a scale from zero (black) to 255 
(white). 

 

Use the slider to adjust the global gain of the camera. The 
global gain of a camera is the factor multiplied to the intensity 
channel of each raw pixel.  A gain of 2.0 is recommended as 
a minimum value on most color CCD sensors, to ensure that 
all color channels saturate correctly. 

 The minimal gain allowable for the camera. 

 
Show the current gain. A new value may also be entered 
directly using the keyboard. 

 The maximal gain allowable for the camera. 

 

Use the slider to adjust the Gamma of the camera. 

 Minimal Gamma allowable for the camera. 

 
Show the current Gamma of the camera. A new value may 
also be entered directly. 

 Maximal Gamma allowable for the camera. 

 
Currently unavailable for all cameras – this feature will enable 
the camera to operate in a 2x2 binning mode. 

 
On any INFINITY3-1 camera model, this feature option will be 
available.  Select the checkbox to enable the cooling function 
on the camera.  When cooling is activated, the fan will be 
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audible on the camera, and the blue LED on the front of the 
camera housing will illuminate.  De-select the checkbox to 
turn off the cooling function. 

 
 

Capture Options 

 
 

 
 
 

 

Select the number of frames to be averaged. 
If 1 is selected, no frame averaging will be 
performed. If 2 is selected, two successive 
frames will be summed and then divided by 
two to create the intermediate image that is 
the input to subsequent post-capture 
processing. 4 and 8 are similarly defined. 
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Frame averaging reduces noise. If n frames 
are averaged, the energy of the noise will be 
1/n of its original level. 
 
Frame averaging is performed only when 
capturing full field of view. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For either the INFINITYX-21 
or INFINITYX-32 camera 
models, the Subsampling 
option is replaced by the 
following: 
 

 

Subsample the output image. If 1 is 
selected, no sub-sampling will be done. If 2 
is selected, the number of columns and 
number of rows of the image will be reduced 
by a factor of two by merging every two 
consecutive columns and rows. 3 and 4 are 
similarly defined. 
 
Subsampling reduces the noise level much 
like averaging.  The way INFINITY 
ANALYZE performs subsampling also helps 
to avoid aliasing. 
 
Subsampling is performed only when 
capturing full field of view. 
 
Pixel-Shift Cameras 
 
Instead of decimating pixels, pixel-shift 
cameras such as Infinity X are decimating 
the original sampling interval, which actually 
leads to an increase of pixel numbers in 
each row and column by the decimation 
factor. 
 

 

Select a destination of the acquired images. 
If File is selected, the image will be stored to 
disk under that file path specified below. If 
Field Group is selected, the image will be 
appended to Field Group if there is still 
room. If Both is selected, the image will be 
stored as a file on disk and also appended to 
Field Group. 

 
Show the file name to be used when the 
captured image is to store on disk. A new file 
name may be entered directly. 

 
Push to bring out a File Save As dialog to 
specify the file name to be used when the 
captured image is to store on disk. 
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 If checked, the image of the full field view will 
be captured regardless of the preview state. 
If unchecked, only the image that is being 
previewed will be captured. This can be a 
sub-region of the full field of view, or lower-
resolution image which INFINITY ANALYZE 
is using for display purpose. 

 If checked, a new image window will be 
created to load a copy of the acquired 
image. 

 If checked and the acquired image is to store 
in a file, a File Save As dialog will be brought 
up after each image is acquired. The file 
name contained in the dialog is initially set to 
the previously specified file name such as 
“e:\report\specimen.jpg”. 
However, it is free to change the file name, 
or instruct INFINITY ANALYZE not to save 
this image to disk at all. 

 If checked and the captured image is to 
store in a file, the file name will be changed 
by INFINITY ANALYZE after the current 
image has been saved. The new file name 
will be used for the next captured image. 
The new file name will have an integer 
appended to the original text and this integer 
will be incremented by one each time the 
new file name is generated by INFINITY 
ANALYZE. 

 The output must be going directly to File, the 
Image File Format must be set to TIFF, and 
the Capture Full Field of View must be 
enabled prior to the 16-bit capture option 
being available.  When this option is 
checked the camera will output either 10, 12, 
or 14-bits into a TIFF image on disk, 
depending on the extended bit-depth 
supported by the specific INFINITY camera 
model being used. 

 Invoke this option to cause the camera to 
perform a snapshot operation using a slower 
clock frequency for improved image noise.  
Without this option being selected, the 
camera will capture an image from the live 
video stream at the fastest clock frequency. 
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There may be a slight color shift observed in 
snapshot captured images. 

 
When this option is selected, the image 
capture will use the exposure time (in 
milliseconds) & gain as specified in the fields 
below this option.  The camera‟s maximum 
exposure time range is indicated.  

 

Enter alternate settings for Exposure in 
milliseconds (left) and Gain (right) that will 
be used when the Capture button is 
selected. 

 

The dropdown list becomes available as 
Exposure / Gain pairs are added by the 
operator.  Selecting an option from the list 
results in it becoming the active exposure / 
gain pair for the Capture operation.  The 
contents of the list are controlled by the use 
of the Add and Remove buttons.  Click Add 
to include the current exposure / gain 
combination as a pair onto the dropdown list.  
Use the Remove button to delete the active 
pair from the dropdown list.   

 
 

4.1.3 Time Lapse 

 
INFINITY ANALYZE is able to acquire a sequence of images automatically, an 
operation referred to as time lapse capture. Two parameters have to be specified to 
start a time lapse capture, one is the time interval, at which the images will be acquired, 
and the other is the span, referred to as duration, of the time which is needed for the 
whole sequence of images to be captured. An image of the sequence will be acquired 
according to the camera settings and capture options at the time when the acquisition 
action occurs. Each captured image will also be calibrated according to the system 
micrometer and sub-sampling factor at the time when the acquisition action occurs. 
Note that the time lapse capture initiated from this sub-pane will be carried out in the 
background. Other functions within INFINITY ANALYZE may still be accessible during 
the time lapse capture. 
 



  Lumenera INFINITY ANALYZE 
Release 6.5.3   User’s Manual 

Copyright  2006-2016  Page 163 

 
 

 
Time interval, in seconds.  Minimum interval is 1 second. 

 
Time duration, in seconds. 

 
Push to initiate time lapse capture. Video preview might be 
necessary if not to capture full field of view. 

 
Push to abort the time lapse capture. 

 The progress of the time lapse capture. Both the number of 
captured images and the estimated time, in seconds, needed to 
complete the task, are given.  

 

Open a Windows Explorer panel and show the contents of all the 
files.  The folder that is opened is automatically set to the location 
where the video clip was stored.  Use the features of the Explorer 
dialog to find the video clip, and with a right mouse clip, select to 
open it with the preferred 3rd-party video player software available. 

 

Click to begin a video clip capture session 

 
Monitor the duration of the video acquisition with the elapsed time 
counter displayed above the Video Capture button 

 
Click to stop the video capture session.  Only the appearance of 
the button changes slightly to indicate the function of the button 
between Start and Stop. 

 

4.1.4 Image Orientation 

 
Depending on the model of the camera being connected, the live image may be 
reversed or flipped. The image orientation, i.e. reversal or flip, may be controlled from 
this sub-pane. 
 

The minimum interval between sequential image captures will depend 
on the camera model, and camera settings that dictate the frame rate 
performance of the camera.  In addition, the ANALYZE application 
imposes a certain amount of processing overhead.  A limit of 1 frame 
per second is imposed by the application. 
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4.1.5 Light Source 

 
The temperature of the light source may be advised to INFINITY ANALYZE to aid color 
reproduction of the camera. The same specimen may appear different under different 
lighting environment because of the different spectral distribution of the light source. 
The camera may incorporate the factor of light source to produce the right colors 
comfortable with human perception. 
 
 

 
 

 Select to indicate to INFINITY ANALYZE that the light source has a 
broken spectrum. 

 Select to indicate to INFINITY ANALYZE to add more red. 

 Select to indicate to INFINITY ANALYZE to add even more red. 

 Select to indicate to INFINITY ANALYZE to add more blue. 

 Select to indicate to INFINITY ANALYZE to add more red and blue. 

 Select to indicate to INFINITY ANALYZE to apply color adjustment for 
an LED light source.. 
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4.1.6 Camera Control Extended 

 
The saturation, hue, brightness and contrast of the camera may be controlled from this 
sub-pane. Note that adjusting saturation of a camera means to modify the saturation of 
each pixel in each frame of the video stream from that camera by the specified amount. 
Note also that the range of saturation of a camera must be scaled to match that of a 
pixel, which is always [0, 255]. The same is true for hue. Brightness and contrast are 
purely camera-specific. All these parameters of the camera are adjusted independently 
of the others, that is, each type of adjustment is separately applied to the raw video 
frames of the camera. 
 

 
 
 

Saturation: 1 

Hue: 0 

Brightness: 0 

Contrast: 0 

 

 
 

NOTE:  If you are having any difficulty obtaining accurate color 
representations from the INFINITY camera, ensure that the following 
values are used in the Camera Control Extended dialog [Clicking the 
Reset button will set these values]:   
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 Use this button to reset all values to their defaults, in 
the Camera Control Extended function. 

 

Use the slider to adjust the saturation of the camera. 

 The minimal saturation allowable for the camera. If 
set to 0, a color camera appears to be delivering 
monochrome images. This is equivalent to 
subtracting 256 from the saturation of each pixel in a 
still image. 

 
Show the current saturation of the camera. A new 
value may also be entered here. The default setting 
is 1 where the saturation of the raw image is not 
modified. 

 
The maximal saturation allowable for the camera. 
This is equivalent to adding 256 to the saturation of 
each pixel in a still image. 

 

Use the slider to adjust the hue of the camera. Hue is 
adjusted independently of saturation. 

 The minimal hue allowable for the camera. This is 
equivalent to subtracting 128 from the hue of each 
pixel in a still image. 

 
Show the current hue that is added to that of the 
images from the camera. A new value may also be 
entered here. Note that for a camera the hue is cyclic 
with a period of 360. 

 The maximal hue allowable for the camera. This is 
equivalent to adding 128 to the hue of each pixel in a 
still image. 

 

Use the slider to adjust the brightness that is being 
added to that of the images from the camera. 

 The minimal brightness allowable for the camera. 

 
Show the current brightness that is being added to 
that of the images from the camera. A new value may 
also be entered here. The default value is 0 where 
the brightness of raw images is not modified. 

 The maximal brightness allowable for the camera. 

 

Use the slider to adjust the contrast of the camera. 

 The minimal contrast allowable for the camera. 

 
Show the current contrast of the camera. A new 
value may also be entered directly here. The default 
setting is 1. 

 
The maximal contrast allowable for the camera. 
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Database 

 
The management of the built-in database, and the interaction of the active image and 
the database, may be carried out from the auxiliary window Database. 
 

 
 

4.1.7 Store 

 

Push  to save the active image and its measurement result to the built-in database. 
 

 
 

 

Specify a caption for the record to create. 
Must be a single line of text. The title of the 
active image is initially displayed but it is free 
to specify a different one. The caption should 
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be unique within the database. Otherwise a 
warning message appears as shown below. 
Answer Yes to replace the existing record 
with the same caption. Answer No to abort 
the storing operation. 
 

 

Specify the date of creation of the record. 
The date initially shown is that of the 
computer. Click to pick up another date as 
illustrated below. 

 
A date may also be entered directly. 

 

Specify the name of the person who is 
responsible for the acquisition, processing or 
measurement of the active image. Must be a 
single line of text. 

 

Specify a single line of text as a note, remark 
or comment. 

 
Push to add the new record to database. 

 Push to exit the dialog and do not modify the 
database in any way. 

 

 

The user account must have write privilege on the folder where the 
database is located; otherwise adding records to the database will not be 
successful.  Typically the database file is in the same location as the 
INFINITY ANALYZE application, however it is also possible to specify an 
alternate file folder location for the database, if required. 
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4.1.8 Load 

 

Push to open the selected record in the database. 
 
Note a record in the database must have been selected for this command to work. 
Otherwise a warning message appears as the following. 
 

 
 
When a record is successfully loaded, a new image window will be created to hold the 
image data from that record. If the image has been measured before, measurement 
information will also be loaded into the auxiliary window Measurement. 
 

4.1.9 Delete 

 

Push to delete the selected records in the database. 
 
Note for this command to work, at least one record has to be selected. Otherwise, the 
following warning message will appear. 
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A deleted record cannot be restored. 
 

4.1.10 Refresh 

 

Push to reset the record list to its default state. 
 
Upon start-up, the auxiliary window Database shows the most recently added records, 
up to 100 entries. After a query has been made on the database, the auxiliary window 
Database shows the resulted record list. Choose Refresh to list the records in the order 
of their creation.  
 

4.1.11 Query 

 

Push to search for particular records in the database. Before the search, criteria of 
search have to be established. 
 
Query by Date 
 

Click and select “Date”. The toolbar of the auxiliary window 

Database shows the two date control where the time interval 
during which the search will be done may be specified. Use the spin buttons to adjust 

starting and ending date. Push to start searching. The search result will be given in 
the record list. 
 
Query by Author 
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Click and select “Author”. The toolbar of the auxiliary window 

Database shows the edit control where the name of the author on which 

the search will be done may be specified. Push to start searching. The search result 
will be given in the record list. 
 
Query by Description 
 

Click and select “Description”. The toolbar of the auxiliary window 

Database shows the edit control where one or more words on which the 

search will be done may be specified. Push to start searching. The search result will 
be given in the record list. 


